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1 Interface Overview

Luxriot EVO Monitor is a dedicated application for viewing live and browsing the recorded contents of connected
Luxriot EVO servers. It also includes advanced features such as video and snapshot export, alert monitoring, PTZ
and digital PTZ control, among others. As Luxriot EVO Monitor is a unified interface for all Luxriot EVO editions,
some of the features described in this document may only be present if you are connected to Luxriot EVO Global
server and are not available for other server types (for example, the video wall feature).

We recommend that end users and CCTV station operators become acquainted with this document in order to
understand the application interface and work out some personal usage strategies.

/. Important: Luxriot EVO server and Luxriot EVO Monitor application major versions must match. Example:
Luxriot EVO Monitor having version 1.3.0 will be unable to connect to servers having versions 1.2.0 or 1.4.0.

Maintenance versions within the same major version (e.g., 1.3.0 and 1.3.1) are compatible, but we still
recommend that you match the software versions strictly for best performance.

/. For best user experience, the display resolution of 1280x720 pixels or higher is recommended for Luxriot
EVO Monitor application, alongside 512MB onboard video memory per display.

General

The Luxriot EVO Monitor interface is mostly intuitive. Elements are manipulated using left mouse button (click,
drag and drop) and mouse wheel (e.g., to change digits in timestamps). Right clicks (pop-up menus of all sorts)
have been eliminated to facilitate the Luxriot EVO Monitor application for usage with touch displays.

The application appearance can be changed to accommodate individual users' needs and preferences. Overlay
elements are adjusted in the Application settings, and component colors - using the Themes tool. These settings,
alongside with local resources (layouts and sequences) and the list of servers can be saved into a file for further
import on other workstations.

The main application functionalities are available via tabs. Visibility of these tabs and certain interface elements can
be controlled for each Luxriot EVO Monitor application instance using the Luxriot EVO Monitor Administration
Tool, which is available via main menu Tools -> Administration Tool.
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The Luxriot EVO Monitor application window title displays window name, display number, computer station name,
and also video wall title and display number.

Most elements (buttons, menu items, overlay elements) have tooltips - text hints that appear when you position the
mouse cursor over the item and hold it for a moment. Tooltips are enabled by default and can be turned OFF

via application settings.

Also, many user interface controls have hotkeys - keyboard shortcuts. Some useful key commands: use ESC
(Escape) to deselect a viewport in live or playback (remove yellow frame); CTRL+Shirt+U will unmap all current
viewports (comes handy on remote connections), and CTRL+Shift+A will map all empty viewports with channels,
filling the layout automatically. Go to the main application menu Edit > Command Mapping to change the hotkey
combinations from the defaults, and define keyboard commands for less popular commands (unassigned by
default).

Application Windows

The main (primary) application window displays contents provided by server or servers in different

modes, depending on the tab selected. All secondary windows only display live channels, without any supplementary
tabs, menus or panels. Please refer to the Interface Elements section of this document for detailed information about
all Luxriot EVO Monitor panels, buttons and other controls.

The Luxriot EVO Monitor application is always running in the single instance mode, meaning that it should only be
launched once. Additional (secondary) windows can be opened on all additional displays.

Upper Panel: Tabs

The upper panel contains tabs that allow you to quickly switch between the main software functionalities. Some
tabs (e.g., Live, Playback) are always present while other ones (Access Control, LPR etc.) only appear when the
related feature or contents is available on one of the connected servers. Tabs are only present for the main
application window.

Upper Right: Connections and Main Menu

The Connection button opens a dialog box with the server list. Next to it, there is the main application menu, which
contains items for the Luxriot EVO Monitor tune-up and additional wizards.

Below the main menu, there is a button for multi-display setup and another one for managing the current
display contents.

Left: Resources
This section displays resources from the connected servers: layouts (including layout templates and sequences),

channels, maps, and user buttons. The resources panel can be hidden by clicking the << arrows in its upper right
corner to free up more display space for the contents.

©2024 A&H Software House. All Rights Reserved.
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2 Interface Elements

This topic covers Luxriot EVO Monitor interface elements in more details.

' Application elements and sections can be configured to be hidden via Luxriot EVO Monitor administration
tool. By default, all functionality is available based on the Luxriot EVO server configuration and license
limitations.

Main Viewing Area

The main (central) viewing section displays contents provided by the connected servers. The type of the contents
depends upon the selected tab: this may be live video, several types of playback, data from external services
etc. Please see the corresponding sections of this document for detailed information about each mode.

M Playback » empty ¥ VA Street

Above all viewports, you will see < arrows >: these allow you to undo/redo the changed you make to the layout in
the live view and playback modes. For example, if you accidentally removed a channel from the view, simply click
the < arrow to the left to go one step back (undo the last action).

e up to 50 actions are remembered in the current application launch

e available for live view, instant playback, and multichannel playback on the main display

e both manual actions and channel popup

e live and playback share history unless the Allow different layouts for live and playback option is enabled

in the application settings (under main menu Edit > Settings > Usability)

The state history is not available while a layout sequence is being played.

Top Right: Window Controls

Standard window controls: go fullscreen, minimize, restore and close
From this panel, the Luxriot EVO Monitor application window can be:

e opened in fullscreen mode

e minimized to taskbar

e maximised/restored to default size
e closed

To toggle fullscreen , F11 can also be used. This is one of the default keyboard shortcuts: to change the action hotkey,
go to main menu Edit >> Command Mapping.

Upper Panel: Tabs

[ Live > Playback 5 Sequence explorer /1 Alerts Library
Luxriot EVO Monitor application upper panel with tabs

The upper panel contains tabs that allow you to quickly switch between main software functionality. The following
tabs may be available, depending on the software version and configuration:

¢ Live: real-time video streams with PTZ controls, data overlay and instant playback

e Playback: recorded video stream investigation

e Sequence: advanced analysis of the recorded video streams

¢ Smart Search: quickly find the target scene using motion search

e Alerts: generated alerts and information level messages

e Library: exported video clips and snapshots

©2024 A&H Software House. All Rights Reserved.
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e Video Wall*: video wall display configuration

e Reports: create diagrams and heatmaps based on the collected metadata

o LPR**:investigation of the license plate recognition results

e FR**: investigation of the face recognition results

e Camio**: investigation of the results received from Camio cloud service

e Data Sources**: investigation of textual data received from configured external data providers
¢ VA Investigation**: External Video Analytics investigation

*The tab only appears when Luxriot EVO Global server connections are present, video walls exist in the Luxriot EVO
Global configuration and the used user account has sufficient privileges assigned via Luxriot EVO Console.

**The tab only appears if corresponding service is supported by Luxriot EVO license, the service has been set up via
Luxriot EVO Console and the used user account has sufficient privileges.

O DR B A | E

When all tabs do not fit in - either because of smaller screen size/resolution or due to decreased application window
size - tab items are collapsed to icons. Tooltips will provide clues

Upper Panel: Server Connections

= Connection (1 servers)

The Luxriot EVO Monitor application Connection button on the upper panel

The Connection button opens server connection setup window and also displays the number of currently configured
servers.

Upper Right: Main Menu

File Edit View  Tools Help

Luxriot EVO Monitor application main menu
This section contains the main application menu items.

¢ File

e Exit: close the Luxriot EVO Monitor application
Edit

e Settings: application settings
e Command mapping: keyboard shortcuts

e Theme: application appearance management
e Video Analytics Connection: allows to set up direct connections to external VA servers (disabled
by default)
e View: operation modes and application view management
e Time presentation: choose between local, UTC or specific server time zone
e Operation modes:
e Always on top/Exclusivity mode/Locked application
Tools: utilities related to Luxriot EVO Monitor application management and other tools
e Import Settings: load application settings from file
e Export Settings: save current application settings to file
e Archive Backup Wizard
e GPU Configuration Wizard
e Administration Tool

Help
e User Guide: opens the Luxriot EVO Monitor application user manual
e About: about Luxriot EVO Monitor

©2024 A&H Software House. All Rights Reserved.
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Upper right: Layout actions

Enable Audio IN for All Channels: Click the Audio IN button in the top-right corner to activate Audio
IN on all channels in the layout

¢ Disable All Audio IN: Click the top-right Audio IN button again to turn off Audio IN for all channels,
regardless of previous settings

¢ Broadcast Audio OUT: Press and hold the Audio OUT (mic) button in the top-right corner to broadcast
audio to all channels. Channels with Audio OUT enabled will display a yellow mic icon

¢ Three dots: Save or share current live view contents
e Multi-dislplay setup: Configure additional windows for secondary displays

Left: Resources

™ Layouts

- Local
B3 Layout sequences
» A Layout templates

» B Layout templates
2C Channels

2Q Awis 215 PTZ on 192.168.3.4

3 M2 on 19216835

3 Samsung SNP-3120V on 192.168.3.11
G Vivotek IPE16A on 192.168.3.12

23 Vivotek PZ7131 on 192.168.3.19
The Resources panel of the Luxriot EVO Monitor application

This section displays resources from the connected servers: layouts, channels and maps loaded from configured
servers. If visual grouping has been configured for the target server, the resources will be arranged into expandable
lists. Visual groups (looking as folders) can be dragged and dropped onto the viewing area whole.

The panel can be docked to the left by pressing the << arrows in the top part of the panel, and restored back by
clicking the >> arrows; individual resource lists can also be collapsed and restored by clicking the subsection name.
Search field in the upper panel part allows you to filter the resources based on the entered text.
¢ Search: global resource search
e Layouts
e Layouts, layout templates and layout sequences
e Local resources: stored on Luxriot EVO Monitor machine

e Server resources: loaded from connected server(s) (shared layouts and server-side layout
templates)

¢ Channels: per server or mixed, if Merge resources option has been enabled in the server connection
properties
e Unavailable channels are marked gl

©2024 A&H Software House. All Rights Reserved.
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e Among regular video channels, there are also CrossLink channels: interactive and non-
interactive webpages (server-side) and workstations
e Maps*: e-maps, per server or mixed
¢ User Buttons®*: software buttons that perform actions, associated with them via Event&Action scenarios;
per server or mixed
¢ CrossLinks: interactive webpages (no recording)

*Some resources may be unavailable for certain software editions.

Channels, maps, webpages and user buttons can also be grouped independently through the Visual Groups
functionality of Luxriot EVO Console. Visual groups can have one or multiple levels, i.e. each visual group can
contain other visual groups, allowing you to create more complex organization of your channels and other resources.

©2024 A&H Software House. All Rights Reserved.
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3 About

Information about the currently running Luxriot EVO Monitor software version can be viewed in following way: in
Luxriot EVO Monitor, go to the main menu, click Help and select About. This dialog box also contains links
to Luxriot website and technical support email for your convenience.

/. Important: Luxriot EVO server and Luxriot EVO Monitor application major versions must match. Example:
Luxriot EVO Monitor having version 1.3.0 will be unable to connect to servers having versions 1.2.0 or 1.4.0.

Maintenance versions within the same major version (e.g., 1.3.0 and 1.3.1) are compatible but we still
recommend that you match the software versions exactly for best performance.

Note that there is no information about the server license here as Luxriot EVO Monitor application can be connected
to several different servers at once. You can retrieve the server license details locally on each server.

About Luxriot EVO Monitor

Luxriot EVO Monitor

Product version 1.1.0.7404 x64#22619

Weh: http:/fwww.luxriot.com/

Email: support@luxriot.com

i

Legal information: hitp://www.luxriot.com/legal

Copynght © 2004-2016 A&H Software House, Inc.

Waming: This computer program is protected by copyright law and
international treaties. Unathonzed reproduction or distribution of this
program, or any portion of it, may result in severe civil and criminal
penalties, and will be prosecuted to the maximum extent possible under
the law.

Help -> About

©2024 A&H Software House. All Rights Reserved.
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4 License Limitations

Please note that, as Luxriot EVO Monitor application is a unified interface for all Luxriot EVO editions, some
features described further in this document may not be available for certain Luxriot EVO server versions.

When the Luxriot EVO Monitor is connected to a server that is operating with a free license, the
following limitations apply:
e each Luxriot EVO Monitor application can be connected to a single free server at a time
e each free server can have no more than one simultaneous Luxriot EVO Monitor connection
e some types of the resources will be not available (e.g., video walls, maps, user buttons, external services,
data sources)

Some features, like video wall, will also be unavailable with Luxriot EVO S servers. Luxriot EVO Monitor
applications connected to Luxriot EVO Global server(s) will provide full functionality.

©2024 A&H Software House. All Rights Reserved.
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5 Server Connections

The main purpose of the Luxriot EVO Monitor application is to display the contents of the local and/or remote
server(s). By default, Luxriot EVO Monitor contains a local server connection entry when it is installed together
with the server.

General client-server connection logic is:

e use server IP or hostname and TCP (VMS) port as configured on the server side
e user account must have enough privileges to connect and retrieve the resources

¢ additional security settings may affect the login procedure, e.g., you may need to enter the login reason or
use two-factor (2FA) authentication to confirm your identity

You can connect to multiple Luxriot EVO servers of different editions within the local network or over the
Internet, using built-in Luxriot EVO users or AD/LDAP domain users (pre-configured on the server side). In the
Luxriot EVO Global system, you simply need to enter the central management server address, and all the
Luxriot EVO Recording Server and mirroring server connections are established automatically. If the Luxriot EVO
Global server goes offline, your Luxriot EVO Monitor application will be redirected automatically to the mirror, if it
exists; if not, the Luxriot EVO Recording Server connections will still be available (without enterprise features
provided by Luxriot EVO Global server).

The list of servers can be saved into a file for further distribution on other workstations via main menu Tools >
Import/Export Settings. This, you can enter the list of server connections with all required user accounts, save it,
and then import the file on other client machines. All settings are stored, except from the user passwords - for
security reasons, the passwords are not kept. You will only have to enter them once after importing the server list.

Q The Luxriot EVO software edition allows a maximum of 1 (one) simultaneous connection to the server; Luxriot
EVO Monitor can also only be connected to one Luxriot EVO server at once. Other software editions have no
limitations in this regard.

3

One concurrent connection to a server is maintained at a time to optimize the network traffic. For certain use
cases, you may want to create multiple connections to the same server with different credentials (having
different permission sets) without saving the passwords and ask each user to choose his profile and enter his
password when starting his session. To ensure that no person uses previous user's session, there is an auto
logout option after certain period of inactivity, which can be enabled in the application settings.

T

Connect to Luxriot EVO Servers

To connect to a Luxriot EVO server via local or public IP or hostname, follow these steps:

1. Create a server connection
2. Choose the connection in the list
3. Click Connect

Click the Connection button in the upper panel to bring up the Server Connections dialog box.

©2024 A&H Software House. All Rights Reserved.
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L1 Live =2 £ Alerts [ Library =Connection (1 serversl  Foe bt View
Save Layould

= B Local

Layout sequences

Connections

o Addd server F D onect
* [ Leymut tem,

* =5 Local server

» [ Layout templates = | ocal server

23 Parking

Open the Connection section from the upper panel

Click the + Add server button to create a new server connection and fill the connection parameters. Alternatively,
choose Edit to adjust the existing server connection settings.

©2024 A&H Software House. All Rights Reserved.
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Connections

Server title

Section 31

IP address and port

localhost

Uiser password

[ Merge resources

Add new server dialog box

The table below contains details about the available parameters.

Setting Description Default
value
Server title User-defined server name Server #N
Server IP address Local/Internet IP address or host name of the target server localhost
Server port TCP port for remote connection 60554
Login method Internal or external* (OAuth 2.0) authentication. Internal
user
User name User account name for remote connection admin
User password Password for the provided user profile [empty]
Domain AD/LDAP domain, if applicable [empty]
Multicast mode Accept multicast streams from the target server (must be enabled on server Disabled
side)
Merge resources Do not display the source server for accessed resources; shuffle server Disabled
resources (for multiple servers)

*Choose OAuth to log in using Google account, Apple ID, Microsoft ID, Okta, or other OAuth 2.0 authentication
provider.

Click Save when you have finished. The server connection created will appear in the item list and Luxriot EVO
Monitor will attempt to establish the connection immediately. Click Disconnect if you do wish to start working with

©2024 A&H Software House. All Rights Reserved.
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the target server later. Click the Remouve button in the upper-right-hand corner to delete any existing server
connection.

/i For you to be able to use the multicast mode, it must be enabled on the server side via Luxriot EVO Console.
Also, multicast traffic must be allowed on all the network equipment on the way from your server to the
Luxriot EVO Monitor.

Server Login

Connections

+ Add sepver

= Saction 31

Auvailable connection list

Select a server by clicking it in the connections' list and click Connect in order to (re-)establish a connection with the
selected server. Server resources will automatically appear in the left hand panel.

) Inthe Application settings, it is possible to set up automatic logout after a certain period of user inactivity. If
this setting is enabled, all the servers will be disconnected from if there is no user activity in the application
interface; default inactivity period is 15 (fifteen) minutes.

Also, for enhanced security: in the admin tool, you can disable the Remember password option, forcing users
to enter the password when they connect to any server every time.

If you chose not to store the password, you will be asked for it every time you re-connect to the target server. In
that dialog box, you will also have an option to change the user domain - you can use a domain that is different from
the one used in the current Windows logon session.

/* When you do not see an option to remember the password, it means your administrator has disabled this
functionality. In this case, you will have to re-enter the password every time.

If your user account does not have a privilege to log into Luxriot EVO Monitor application without entering login
reason, you will be also asked to provide a justification for this server session. The entered text will be logged in the
server audit log. This is an additional security feature and it can be disabled by adding the corresponding user
permission in Luxriot EVO Console, under Administration profile in the user account settings.

©2024 A&H Software House. All Rights Reserved.
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Local Server

User name
| admin I

Lser password

Dlomain: unspecified

Connect Disconnect

Specify the password to establish the connection with the target server

Server policy of the Luxriot EVO server may limit the number of login attempts. If you enter a wrong password
more than the number of times specified by that policy, your user account will be blocked. Your system
administrator can unlock the user account via Luxriot EVO Console.

SERVER NAME CONNECT CHANNELS STATUS ERROR

= |ocal Yes 0 Account is locked

Click Disconnect in this same dialog box to log out from the selected server.
Two-Factor Authentication

This application supports two-factor authentication as an additional security measure for the user login. It does not
eliminate the necessity to enter the user password; instead, it serves as an additional security layer.

If the target server has two-factor authentication (2FA) policy enabled, you will be asked to confirm your identity by
requesting and entering a code. Depending on the server configuration, the code may be requested by email or by
SMS.

! 2FA s configured by the Luxriot EVO server administrator, so if you have any issues with requesting,
receiving, or entering the code, contact the person who maintains the target Luxriot EVO server. Provide the
server administrator with your valid email and full phone number.

! The 2FA settings affect all users and all clients by default; the system administrator can set up exceptions for
localhost connections and also for individual users.

The login procedure with 2FA is as follows:

¢ an additional dialog box pops up upon the server connection attempt
e choose one of the provided verification methods and click Request code
¢ in the next dialog, you will see a session ID and an empty box

o check your email or phone (or other provided verification source) for a message with the same session ID
(for example, marked as #6708 here) and copy the code from the message body (1234 here)

o click Submit code: if everything is OK, you will be logged in

©2024 A&H Software House. All Rights Reserved.
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The verified session will be active until you log out manually, close the Luxriot EVO Monitor application, or
your session expires after a period of inactivity. If the target Luxriot EVO server disconnects for some reason, the
session will be restored automatically, and you will not be asked to request the code again.

MyLapTop X | MylapTop

Two-factor authentication Two-factor authentication

Choose verification method:
1 the identifier in the n ontaining the

email Request code

Enter code

1234 Submit code (9:50)

Cancel

Luxriot EVO Monitor login using two-factor authentication

If you have trouble receiving the code, please ask your Luxriot EVO administrator to check the settings for you.
Possible issues may be:

your email/phone number is not specified in the system or it is incorrect
the automatic email is filtered - check your Spam folder

e your phone has a spam filtering app

¢ make sure you are entering the code itself, not the session ID

Enter code

1111 Submit code (9:54)

You have a limited time interval to enter the code. When the code expires, you will need to request a new one. Your
system administrator can adjust the code validity period.

Try again

©2024 A&H Software House. All Rights Reserved.
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Log In Using OAuth (External Authentication Providers)

When connecting via Luxriot EVO Monitor, there is an option to choose external authentication - Google, Apple
ID, Microsoft, Okta, or other - instead of the regular user account.

Connections

Server title

Laptop

IP address and port

localhost

Authorization method

OAuth 2.0

Choose an autho ethod to log into the server

v Remember me

External authorization option in Luxriot EVO Monitor

To do so, choose OAuth 2.0 as the authorization method and save the settings. You can also choose to Remember the
login so that the application does not ask for authorization again during the same session (session time is defined in
Luxriot EVO Console by the software administrator) if you disconnect from the server and try re-connecting. For
instance, the session may be set equal to the operators' shift.

Laptop X  Laptop

OAuth 2.0 authentication OAuth 2.0 authentication

Choose authorization method:

S A SsE Il Flocend Please enter your login credentials in your

- GOOGLE ACCOUNT o Web browser, and then go back here.

tr
Microsoft

Cancel Cancel

External authorization steps in Luxriot EVO Monitor

When you try connecting to the server, you will be offered to choose the authentication provider if there are multiple
available. Choose whichever you like and click Proceed: a Web browser page will open automatically, asking you to
enter the user credentials. If you have already logged into the server using this method earlier from the same PC, the
success message will appear immediately. For some providers, you may have to confirm that the application
requesting the authorization is safe.

Return to the Luxriot EVO Monitor app.

©2024 A&H Software House. All Rights Reserved.
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Authorization data received successfully.

Please close this page and continue authentication process -

An example of a success message in the Web browser page

If this is the first time you log in with the current user account, you will be asked to enter the security token.

) If you want to change the user to a different OAuth user, deselect the Remember me option in the server
settings, disconnect from the server and try connecting again.

Server Grouping Options

To make it easier to navigate in multi-server setups, we added the Server Grouping option to Luxriot EVO Monitor
version 1.25. It is now possible to group servers inside Luxriot EVO Monitor by adding or removing a server without
additional settings in Luxriot EVO Console.

1. To Add a server to the group - go to Luxriot EVO Monitor and click on the Connection tab in the top panel.

2. In the Connections window, select the Server you want to add to the group and click the Assign to Group
button.

3. Select an existing group from the dropdown menu and click the OK button.

4. If no group exists or you want to create a new server group - select New server group from the dropdown
menu, provide the Server Group Name in the respective field, and confirm with the OK button.

£\ Alerts Library  FEH Video Wall Data Sources  |ull Reports FR [ EVAALPR [ EVAFR [ EVAObjects {_jLPR = Connection (1 servers)

Connections

o Server o Cloud server [beta) Remove from group i Disconnect Disconnect all
AE LS STATUS
M onemoreGroupToTest
- -SEweerumem

= | ocal Server

Assign to group

Assign server(s) to group

Server group name

An example on how-to assign selected Local Server to the Group in the Luxriot EVO Monitor Connections window

/. Worth noticing: If you select the existing server group from the dropdown menu and rename it in the Server
group name field, you will add the Server to the server group, but it will change the existing server group
name.

/. You can import Servers and Groups using Import Application Settings (Application menu -> Tools -> Import
Settings). If the imported Server host matches the Server host that already exists on your local setup, your
local setup will have priority, and after import, you will see your original Server. You can learn more about

©2024 A&H Software House. All Rights Reserved.
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import and export Settings in Application Settings section.

©2024 A&H Software House. All Rights Reserved.
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6  Application Settings

Luxriot EVO Monitor settings let you define the appearance and behavior of the application, as well as pre-define

some defaults, such as video and snapshot export defaults.

Application settings are reachable via the main menu by clicking Edit -> Settings, and these cover all configurable

options of the program GUI. Note that parameters here are defined for the whole application and cannot be set
separately for application instances and/or individual layouts, channels etc.

These settings can be saved into a separate configuration file and later imported in any other Luxriot EVO Monitor

application, including application instances on other workstations. The export/import procedure is described at the

end of this topic.

General

General settings like the application language, automatic logout, exclusivity mode parameters etc. can be found here.

General section of application settings

The table below contains a detailed description for each setting.

©2024 A&H Software House. All Rights Reserved.

Setting Description Default Value
Language Choose language for the application interface from the list of available Language set
localizations (requires application restart); will affect both Luxriot EVO during
Monitor and Luxriot EVO Console applications, if installed installation,
English by default
Application Enable the application to be started in the specified mode Regular
startup mode | (locked/exclusive/both/none); regular = no special mode
Interactive Override or allow OS screensaver System Settings
user idleness
action
Auto logout If enabled, all the servers will be automatically disconnected after a certain Disabled
after user period of user idleness
inactivity
User idleness | Time period in minutes, after which the auto logout will be executed 15 minutes
timeout
Pop up If enabled, you will get a floating message box with details every time a server | Disabled
message box is disconnected
upon server
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disconnect
Exclusivity Defines if exclusivity mode is applied to all monitors or currently opened Opened screens
mode* application instances only only
Exclusivity User-defined password for unlocking exclusivity and locked application [none]
mode modes (You need to set the password before the system will allow you to turn
password on exclusivity mode)
Enable Turn ON application behavior monitoring: Luxriot EVO Monitor watchdog | Enabled
watchdog will restart the application if it freezes or hangs during operation or on

startup (it is highly recommended to keep the watchdog enabled)
Show update | Enable application update notifications from connected servers Enabled
notifications

*Exclusivity mode settings:

o All Monitors mode will force fill all displays with child Luxriot EVO Monitor application instances upon
enabling exclusivity mode

e Opened screens only mode will still allow background application/OS access via displays where no Luxriot
EVO Monitor is launched

/. Important: Luxriot EVO server and Luxriot EVO Monitor application major versions must match. Example:
Luxriot EVO Monitor having version 1.3.0 will be unable to connect to servers having versions 1.5.0 or 1.15.0.

Maintenance versions within the same major version (e.g., 1.17.0 and 1.17.1) are compatible but we still
recommend that you match the software versions exactly for best performance.

Navigating settings

You can simplify navigation through settings by using the search option. Locate the field with the magnification lens
icon at the top-left side of the settings window and

General Settings

General

l e
Usability Language

English
Viewport overlays

Library

Snapshots export
Application startup mode
Video export
Regular

Sounds

Video Analytics

HTTP APl : . ;
Interactive user idleness action

Search field example
Usability

This section contains settings related to the application controls and interaction with the application elements:
different playback modes, DPTZ etc.

©2024 A&H Software House. All Rights Reserved.
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Setting Description Default
Value

Show tooltips Show hints when hovering over some element with the mouse cursor Enabled

Auto-expand Automatically expand the contents of the connected servers in the resource Enabled

server nodes tree

Auto-expand Automatically expand the contents of the existing visual groups in the resource | Disabled

visual groups tree

Show alarm pane | Enable to bring up the alarm pane containing bookmark alarms from Disabled

connected servers

Maintain original | Keep original picture proportions; when OFF, image will be stretched to fill in | Disabled

aspect ratio the viewport (this setting can be overridden for each individual viewport)

Pause decoding If enabled, decoding for background channels will be terminated when one of | Disabled

for background the channels is maximized*

channels

Pause data If enabled, streaming will be paused for the rest of the channels when one Disabled

transmission for | channel is maximized*

background

channels

Default Default state of the substream toggle when the channel appears in the High

substream mode | viewport. High = force main stream, Low = force substream, Auto = let

software decide based on viewport size

Default DPTZ Choose how digital PTZ behaves by default: region mode or PTZ emulation Region

mode

Timestamp See separate table below Enabled

settings

Show decoder Show whether and which GPU is currently used for live video decoding Disabled

information

Extend layout If enabled, each user interaction with the layout contents resets the sequence | Disabled

sequence duration countdown to the specified number of seconds IF the remaining time

duration upon is shorter

user interaction**

Interaction with | Choose how you want to activate map markers (channels, links to other maps | Double click

map markers etc.): with a single click or a double click

Enable live If enabled, you can hover the mouse over channel markers to see the live Enabled

preview on maps | channel preview

Instant playback | Default timeline size for the instant playback mode, in seconds 300

default duration

Instant playback | Default amount of time in seconds to "jump back" when switching from live to | 60

rewind instant playback mode

Pause instant If enabled, instant playback will be paused after switching from live view Disabled

playback by

default

Timeline Choose whether you want to see the timeline for the currently selected channel | Selected

presentation in only, optionally with an additional timeline containing all displayed streams' channel plus

playback mode summary, or a separate timeline track for each channel present in the layout a summary
timeline

Preview Choose which elements appear when you hover the mouse over the timeline in | Video frame

thumbnails on the | playback (video thumbnail for timeline and/or bookmarks, or just bookmark | for timeline

timeline details) and
bookmarks

Allow different If enabled, the application will stop synchronizing layouts between live and Disabled

layouts for live

regular playback, allowing you to select a proprietary channel arrangement for

©2024 A&H Software House. All Rights Reserved.
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and playback playback by dragging and dropping it onto the viewing area

Pause when Defines how +/- and mouse wheel behaves when controlling playback speed in | Enabled
playback speed is | regular playback. Disable this setting if you wish to have contiguous speed

decreased control (one click in any direction increases or decreases speed by one step)

Prefer substream | Use recorded substream for playback, if available; this setting is good for low | Disabled
for archive bandwidth connections
playback

Enable automatic | Enable this option if your channels tend to be recorded on different servers Disabled
stream selection | (e.g., failover is in use) and you want to have automatic switching between
streams during playback

Notification panel | Font size for the messages appearing in the overlay notification panel 14
font size

External service | Choose opacity level of the [colored] events from external services that appear | 30
event background | in the viewport notification area. o=transparent, 100=opaque.
opacity
Show images for | Keep this enabled if you want to have a thumbnail (if available) alongside with | Enabled

external service result received from the connected external services
results

*If decoding/transmission is stopped for the background channels, a certain amount of time is required to restart
the decoding after the foreground channel has been minimized back to its viewport. Thus, enabling this option will
decrease CPU/bandwidth utilization but increase the delay in presenting the rest of the channels when switching
back from the maximized channel view.

**Example: a layout sequence is played and only 23 seconds are left for the current layout. The user clicks a viewport
to save a snapshot: the sequence continues to play. Now, only 14 seconds are left for the current layout. The user
clicks another channel viewport to save the second snapshot; the current layout countdown is set to 15 seconds
(default setting value) so that the layout does not switch in the middle of the user's action. The countdown will be
reset each time the user clicks again. Finally, the user does nothing and the sequence switches to the next layout.
Note that this setting does not affect the layout duration in the sequence settings.

Timestamp Settings

The timestamp is the time displayed over each viewport. All viewports have the same timestamp position and visual
settings. By default, the timestamp is a small red label anchored to the top right corner; it fills the whole viewport,
and consists of hours, minutes, and seconds.

You can modify the timestamp appearance, or remove it altogether and use camera-side timestamps instead. Note
that the Luxriot EVO timestamp value may differ from that of the camera-side. Also, note that the top left and
bottom left/right corners of the viewport are filled with overlay controls by default, so if you place the timestamp
there, it may be overlayed by those.

The following detailed adjustments are available for the timestamp:

Setting Available Items Default
Value
Show Display the server/client time as channel viewport overlay (in the top right corner of Enabled
timestamp | each viewport by default)
Show If enabled, the timestamp overlay will have milliseconds in addition to hours, minutes, Disabled
milliseconds | and seconds
Font size Font size for the timestamp 12
Font color Font color for the timestamp Red
Word wrap | If disabled, the text that goes beyond the timestamp area may be cropped Enabled
Position* Choose one of the presets (top left/right/center or bottom left/right/center) or define Top
your own custom position (will unlock the fine-tuning settings below) right

Horizontal | The relative horizontal position of the left boundary of the timestamp (0.0 = leftmost, 1.0 | 0
position = rightmost)

©2024 A&H Software House. All Rights Reserved.
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Vertical The relative vertical position of the upper timestamp boundary (0.0 = viewport top, 1.0 = | 0
position viewport bottom)

Width The relative horizontal size of the timestamp 1
Height The relative vertical size of the timestamp 1

Horizontal | Choose if the timestamp is anchored to the left corner, right corner, or viewport center Right
alignment

Vertical Choose if the timestamp is anchored to the viewport top, bottom, or center Top
alignment

*For most cases, one of the pre-defined positions should be enough. If none of these fits your needs, you can create a
custom position by changing the timestamp size and anchors. All position boundaries and sizes are relative to the
viewport size and can be set using decimal values [0.0..1.0].

Viewport Overlays

Viewport overlays are items displayed on top of the video stream. These are miscellaneous controls, buttons,
statistics and metadata.

General

Viewport overlays

Viewpaort overlays
Library
Snapshots export
Video export

Display st

Writing On Disk
+ Motion Detection
raor Video Resolution
Video Compression
Video FPS

7imes Video Bitrate

Instant Playback

o+ PTZ Toggle

Viewport overlay section of application settings

You can assign separate settings to each overlay item. Note that, regardless of application settings, some of the
controls are not displayed if corresponding action is not available for the target device, e.g., the Instant Playback
control item is not shown if there is no recorded archive. The following options are available for each control:

e Always ON: always display the overlay element

¢ ON if selected: only display the element when the viewport is selected (yellow frame appears)

¢ Always OFF: never display the element

For your convenience, visual overlay items are previewed on the left side of each setting.

Section Available Items Default Value

General | Items displayed in the upper-left-hand corner: Always ON
e Title (device or resource name)

a Macn (o anntral allaunna +a alaca tha airrant
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stream and free the viewport)

Lock (a control allowing to lock the stream in its
current viewport, making it immune to pop-ups)
User buttons: one or multiple items

Display
status

Data displayed in the bottom-left-hand corner of the

viewport:

Writing On Disk (recording status)

Motion Detection (motion presence)

Video Resolution (picture size)

Video Compression (stream video codec)
Video FPS (stream frame rate)

Video Bitrate (data amount, bits per second)

ON if selected

Display
controls

Controls displayed in the bottom-right-hand corner of the

viewport:

Instant Playback (switch mode)

PTZ Toggle (PTZ and preset controls ON/OFF)
Digital PTZ Toggle (DPTZ ON/OFF)

Motion Detection Grid Toggle (MD grid ON/OFF)

Substream Mode Toggle (switch displayed stream:
main/sub/auto)

Maintain Aspect Ratio Toggle (auto/fill/original)
Export Snapshot (save frame to library)

Add User Bookmark (create bookmark and add it
to the timeline)

Input Audio Toggle (incoming audio ON/OFF)
Output Audio Toggle (a press-to-speak audio OUT
control)

Toggle Notifications Pane (ON/OFF)

Send to Sequence Explorer (switch to sequencing
mode)

Send to Smart Search (switch to motion-based
search)

ON if selected, except for PTZ controls
and Send to Sequence/Smart Search
buttons

PTZ
Controls

Pan, tilt and zoom controls:

PTZ Controls (PTZ functionality ON/OFF
regardless of HUD/classic sphere presence)*

PTZ HUD (Heads Up Display, virtual PTZ sphere)
Iris Slider (iris open/close)

Focus Slider (manual focus control)

Zoom Slider (zoom IN/OUT)

PTZ Toolbar (advanced PTZ controls: presets,
tours)

Classic PTZ Overlay (old style virtual PTZ sphere,
visual alternative to HUD mode)

ON if selected, except for Classic PTZ

Digital
PTZ
Controls

DPTZ and dewarp manipulation tools (OFF by default; when
ON, Picture-in-Picture mode and DPTZ toolbar are ON by

default):

Digital PTZ Controls

Zoom slider (DPTZ zoom IN/OUT)

Picture in Picture (small preview window in the top
left viewport corner when zoomed IN)

Digital PTZ Toolbar (advanced DPTZ controls:
presets, dewarp modes)

©2024 A&H Software House. All Rights Reserved.
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Motion Show motion detector grid overlay (for software-side MD Always OFF

Detection | and only some device-side MD)

Video Channel shortcuts: interactive colorful links to other Always ON

Overlays | channels (set up via Luxriot EVO Console

VCA Server-side video analytics metadata overlaying video Always ON
stream:

e Zones (detection areas)
e Counters (indicators associated with VCA rules)
e Objects (all detected entities)

e Non-Alarmed objects (those not having triggered
any VCA rules)

e Speed (object speed)

e Height (object height)

e Area (object size, approximate area it takes)

¢ Class (object type according to defined internal
classification)

o Identifier (internal VA/VCA engine ID for each
object)

e Value* (service-specific value related to
recognition or analysis)

*VCA object value is a service-specific information about the object. The actual value type may differ for different
analysis types. For example, for facial recognition the value will contain subject name and surname, but for LPR -
the car license plate.

These settings are stored in the Luxriot EVO Monitor application configuration file and are preserved when the
application is closed and reopened.

i *If you set PTZ Controls (Manipulation) to Always OFF, you will have to use the PTZ Toggle overlay control
in order to enable PTZ functionality in live view. If you disable PTZ toggle overlay button, too, user will have
no access to PTZ from the viewport. In other words, PTZ Controls setting affects actual PTZ manipulation
availability regardless of presence of the visual controls (HUD or classic PTZ sphere overlay).

Library

Library is the folder containing all video files and snapshots exported via Luxriot EVO Monitor application, as well
as related jobs - for example, file copying to another location, including CD/DVD. This section allows you to define
the library path and some other settings.

General

Library

Viewport overlays

library Library location

Snapatiols Sxport CAUsers\MrSpockiDocumentsiClient Application

Video export

Library section of application settings
Define the default location for snapshots and exported video to be saved to. The original default location is:
C:\Users\<Windows_ User>\Documents\Luxriot EVO Monitor

The only additional setting here is Show "Save file" dialog box: if enabled, the dialog box will pop up every time you
export a snapshot or a video file, allowing you to select a custom file destination every time.

©2024 A&H Software House. All Rights Reserved.
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Snapshot Export

Luxriot EVO Monitor supports both single channel and multichannel snapshots (the latter is available from
Playback mode only). Naming settings here affect both types; for multi-frame snapshots, the channel name
$(StreamTitle) will be replaced with the word Multichannel.

General

Snapshots export
Viewport overlays

Snapshot file name
Library Elani

Snapshots export ${Year)-$(Month)-${Day) ${Hour)-${Minute)-$(Second)-$ (Millisecond) ${StreamTitle)jpg

Video export

»" Always use snapshot export settings

Snapshots Export section of application settings

Set file properties for the exported snapshots. The table below contains a detailed description for each setting.

Setting Description Default
Value

Snapshot file name File name for exported JPEG snapshots; $(variables) are used for automatic Set of
timestamps and other text macros variables

JPEG quality Picture quality, 1 (worst) to 100 (best) 60

Subtitles Hard merged subtitles with configurable font; click the Properties button to Enabled
select the subtitle contents and appearance

Generate PDF report | If enabled, the frame will be saved with details as PDF document Disabled

Always use snapshot | If enabled, the settings above will be used for all exported snapshots; Enabled

export settings otherwise, the user will be prompted for these every time

Video Export

Set the default video export settings here. All the file types will be playable by the Luxriot EVO Portable Player
application so it is up to you, which ones to select; the settings affect file size and subtitle type availability. Also,
some of the formats are required for certain features to work: for instance, POS data overlay is only supported as
hard subtitles for MKV format with VP8 compression.

Each format has its pros and cons:

e AVI, original format: quickest, small file size, no subtitles or extras

e AVI + JPEG compression: allows choosing full/quarter resolution, hard subtitles supported; requires
more time, large file size

o MP4: small file size, soft subtitles
e MKV, original format: extra small file size

e MKV + VP8 compression: medium file size, additional options available (motion blur, time lapse, data
overlay), any subs, takes most time

) If you wish to embed the external textual data with the video, use MKV export format with VP8
compression. MKV format also exclusively allows to export video in time lapse mode.

©2024 A&H Software House. All Rights Reserved.
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General
Viewport overlays
Library
Snapshots export

Video export

Video Export section of application settings

Video export

Video file name

$(fear}-5{Month)-${Day) ${Hour)-$(Minute)-$(Second) $(StreamTitle)

Video output file type

AVl

Video compression

Onginal - Video quality remains as received from a camera. (Recomm

Resolution

Full

The table below contains a detailed description of each setting.

Setting Description Default
Value

Video file name | File name for the exported video; $(variables) are used for the automatic timestamps | Set of
variables

Video output Choose between AVI, MP4, MKV and frame series. AVI

file type

Video Keep the original compression or use an output-specific compressor. Original

compression when
possible

Resolution Choose between full and quarter original resolution if regular compression is used Full

Time lapse Time (in seconds) to be fitted into one second of output video 60

(MKV only)

Include external | If enabled, the data source (text) overlay will be embedded with the exported video Disabled

data

(MKV+VP8

only)

Subtitles Enable hard merged or soft subtitles for the exported video (availability may depend | Disabled

on the format and compression); click the Properties button to set the subtitle
format and color

Maximum Limit the multichannel video export from playback mode to this total resolution. 2MP

resolution for Multiple streams will be then compiled into a single video file, its resulting FullHD

multichannel resolution not exceeding this value. Options: 2MP/4MP/4K/8K (1080p)

export

Always use If enabled, the settings above will be used for all the exported video clips, otherwise | Enabled

archive export the user will be prompted for these every time

settings

©2024 A&H Software House. All Rights Reserved.
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Sounds

Here, you can enable/disable sounds and choose sounds settings for the server notifications.

When event sending to the clients is configured on the server side, it is merely the sound index number (1-10) that is
set, and different notification sounds can be defined for each Luxriot EVO Monitor application. It is also possible to
disable sound for all or any individual notification.

General
Sounds
Viewport overlays

Library »" Enable sounds

Snapshots export
Video export
Sounds

Audio Motification 1 ServerMotificationl.wav

Audio Motification 2 ServerMotification2.wav

Sound settings for notifications
Options:

e unmark the Enable sounds setting to disable audio notifications (enabled by default)
¢ for every audio notification (1-10) it is possible to:

e set the standard notification sound (default), or

e disable sound (select None), or

¢ choose your own .wav or .mp3 file to be played.

Use the Play/Pause buttons on the right to verify that the audio file sounds as desired.

=

‘' Note that, once you set a custom sound or no sound for some notification, the default sound will become
unavailable.

7 When an audio notification is triggered during system operation, there is no option to stop it - the whole audio
file will be played back. Keep this in mind when choosing custom sounds. Default audio notifications are quite
short.

Video Analytics

This section contains settings specifically related to the visualization of all kinds of video analytics (VA), and
includes several subsections.

The table below summarizes the settings for the video overlays. Similarly to the common video overlays, three
options are available for each element:

e Always ON: always display the overlay element

e ON if selected: only display the element when the viewport is selected (yellow frame appears)

e Always OFF: never display the element

Some of the elements are not independent, but are rather details of the main overlay element (e.g., class and area are
details of the VA object).

Setting Description Default
Value

Zones Video analvtics detection zones Alwavs

©2024 A&H Software House. All Rights Reserved.
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ON
Counters VA counters for counting objects Always
ON
Objects Objects detected and classified by video analytics that triggered a VA rule Always
ON
Non-alarmed objects | Objects that were detected but did not trigger any VA rule Always
ON
Speed Estimated object speed, if available Always
ON
Height Estimated object height, if available Always
ON
Area Estimated object size, if available Always
ON
Class Object class, as classified by the running VA engine Always
ON
Identifier Object ID Always
ON
Value Detected value, if applicable (LPR number plate or person's name for FR) Always
ON
Additional settings:
Setting Description Default
Value
Analytics | The opacity of metadata visuals (bounding boxes etc.) in percents; o = fully transparent, 100 | 30
metadata | = opaque
item
opacity

Finally, you have an option to control all colors of all VA object classes, including unclassified and unknown objects.

W rrrraso0

To change the target color, uncheck the Random option and click the color on the right, then choose the desired hue
from the palette.

HTTP API
Settings in this section are for development purposes. Do not change them unless instructed so by Luxriot engineers.

Import and Export Application Settings

Luxriot EVO Monitor application preferences can be saved and exported as a file, so that they can later be used on
other workstations running Luxriot EVO Monitor, or restored on the same workstation after re-installing the
software. When importing, make sure that the Luxriot EVO Monitor version on the target PC is the same or newer.

It is possible to handle the following settings:

e Server connections: the list of server addresses, ports and user names, as well as connection properties

e Application settings: all appearance and usability settings defined under main menu View >
Application settings plus keyboard shortcuts (see exceptions below)

e Local resources: local channel layouts and also layout sequences
The following settings are NOT exported:

e paths: video export library and sounds

©2024 A&H Software House. All Rights Reserved.
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e application themes (export available via themes tool)
e administration tool preferences
¢ window settings (multidisplay setup)

To export your preferences, go to the main menu in the top right corner, and choose Tools > Export Settings. A
separate dialog box will pop up.

Export application settings

File path

| Past

KAMyConfiguration.bxm

Enter target file name and path, and choose what settings should be exported

In the export dialog box, choose the destination folder for the *.1xm file. Below, select what settings will be exported;
by default, all of them are chosen. You can save the settings partially, for example, export the list of server
connections into a separate file. When ready, hit the Export button. After the export is complete, you will get a
confirmation; and, you will get a warning in case the target file cannot be created (e.g., not enough user permissions
to write to the specified location). In the latter case, select a different folder and try again.

The import procedure is very similar: go to the main menu Tools > Import Settings, locate the *.Ixm file, select
desired settings to be loaded and click Import. Note that the imported usability settings will overwrite the existing
ones, and the resources are imported using the following logic:

¢ layouts and layout sequences with identical names will not be imported - currently present resources have
priority

e servers with at least one different connection property (IP/host, port, domain or user name) will be
appended

For instance, when importing a list of servers with the same host name and port but different user names, all servers
will be appended to the connections with their corresponding names. Servers with identical connection properties
but different preferences (merge resources, multicast/unicast) will be ignored (not imported).

©2024 A&H Software House. All Rights Reserved.
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7 Live View Section

Click the Live tab on the upper panel in order to switch to live video monitoring.

The panel on the left displays resources from connected servers: layout templates, layouts, channels, maps and user
buttons loaded from configured servers.
e Search: global resource search
¢ Layouts and layout templates
e Local resources: stored on Luxriot EVO Monitor machine
e Server resources: loaded from connected server(s)
¢ Channels: per server or mixed, if the Merge resources option has been enabled in server connection
properties
¢ Among regular video channels, there are also CrossLink channels: interactive and non-
interactive webpages (server-side) and workstations

e Maps*

e User Buttons*

e Webpages**: interactive webpages
*Some resources may be unavailable for certain software editions.
**This type of resource requires an additional license.

Depending on the resource type, you may be able to click and/or drag items. See the relevant sections of this manual
for detailed information on how to use and manage each of these resources.

] Live [> Playback I Sequence explorer {2y Aleris Library = Connection (1 servers)  Fle  Edit  View  Help

dd
-

Observing Save Layout =

» Layout templates

w [= Layout templates

36 Axis 215 PTZ on 192.168.3.4
2C M2 on 192.16835

g SNP-
€ Vivatek IPB16A on 19

3G Vivotek PZ7131 on 102.168.3.19

Live view in Luxriot EVO Monitor

From the Layouts menu on the left, select your desired layout template and then drag and drop it into the
viewing area. Next, drag and drop channels from your desired server to the empty slots, using the Channels menu
section on the left. Layout templates can be selected either from default local templates or from server layout
templates. The latter can be created on the specified server via the Luxriot EVO Console management application.

You can save the current layout using the Save layout button in the upper-right-hand corner; it will become
available in the layout list on the left under the target server name. Right next to it, there is a button that can be used
to auto-detect displays, which is especially useful in multi-monitor systems.
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] Live > Playback I Sequence explorer \ Alerts Library = Connection (1 servers)  Fle  Edit  View  Help

'
Observing Save Layout o=

P X Central Park e

w [ Local
=1 ayout sequences
=] Layout templates

w [E Layout templates

mi
LS
G Channels
3G Alley North
:X:Alls:'_.a South
€ Central Park
L M2on

3G Samsung

Live view with custom layout

Drag and drop or double-click a channel to place it onto the layout template (double-click works for the primary
window). Channels having no video stream (e.g., camera offline) are marked with red in the Channels section of the
Resources list.

Channel name is displayed in the top left corner of each viewport; the current server time will appear in the upper-
right-hand corner.

Click any live viewport to bring up additional channel-specific parameters and quick controls. Overlay preferences
can be changed via Application settings. By default, these are:
e Upper-left: general viewport controls
e X - close live stream and free viewport - available with or without viewport selection

o viewport lock status: unlocked (default) or locked; unlocked means that the viewport can be
used for map/camera pop-up

¢ camera name
e user buttons, if assigned

e Upper-right: current time, according to the selected time presentation (server, client or UTC); you can
change it via main menu View >> Time presentation

e Lower-left: stream details
e recording status: X = not recording, yellow arrow = recording
e motion detector status: running = motion present, standing still = no motion detected
¢ video codec of the stream
e picture resolution, abbreviated
e stream frame rate, FPS
e stream bitrate, KBytes/s or MBytes/s
e Lower-right: controls; enabled items are highlighted yellow
¢ instant playback (not available if there are no recordings)
e PTZtoggle: PTZ HUD and bottom panel ON/OFF
e DPTZ toggle
e motion grid ON/OFF
¢ incoming audio ON/OFF (if enabled and supported by camera/software integration)

e audio OUT: press and hold the microphone to speak (control is present only if the feature
supported by camera/software integration)

e substream: auto/main/substream
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e aspect ratio (auto/stretch to fill viewport/original)
¢ notification panel toggle
¢ snapshot export to library
e Bottom: PTZ controls
e Presets
e Tours
e HUD (Heads Up Display) ON/OFF
e Centre: PTZ HUD controls
Pan and tilt arrows
Zoom slider
Iris slider
Focus slider
The currently selected viewport will be highlighted with a yellow frame. By default, the selected viewport will have

more overlay controls. You can use ALT+Left/Right on your keyboard to jump between viewports, and ESC to
deselect (remove yellow frame).

Webpages have their own set of controls.

X MmN JPEG OBMP 10FPS 36M/S _ - Ay ’.‘. a

Click the channel live picture to display additional options

The upper-right-hand corner of live view section contains controls for multimonitor and video wall setup.

-
==

On the right side of the application window, there is the alarm pane, which displays the arriving bookmark alarms.

e If the pane is hidden, enable it via Application settings: Usability > Show alarm pane
e Contained alarms are generated by connected servers (action: create bookmark) and must therefore be
pre-configured by the system administrator
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8 Multidisplay Setup

Click the Multidisplay setup button in the upper-right-hand corner of the live view, next to the Save layout
button, to bring up the display selection menu.

Luxriot EVO Monitor automatically detects computer display configuration directly from Windows display settings:

click Identify to show the display numbers on all monitors - it is helpful if there is a large number of displays. To
change your multimonitor configuration, go to the Windows Control Panel -> Display -> Screen Resolution.

/i Please note that in some rare cases, Windows display configuration may be affected by third-party software,
multiple GPUs, or manually edited registry entries, so the best way for intricate setups is to trust display
identification provided by the Luxriot EVO Monitor.

= Connection (1 servers) File Edit View Help

Save Layout

ng SNP-3120V on

' L]
Multiple display selection

Luxriot EVO Monitor automatically detects which screen it is currently on: this display is marked blue and it is not
possible to create any child windows on it. Click on any other empty display (marked gray) to open a new live view
window there: the child window will be opened maximized, with the display number shown in the application
header. The controls in the upper-right-hand corner give the option to enter fullscreen or to close the extension
windows.

For the multiple display configuration, the following logic is applied:

e the main Luxriot EVO Monitor application window acts as a parent window, in the sense that:
¢ child windows for extension screens can be created and closed independently
¢ when the main application window is closed, all other windows are closed as well

e the main window can be located on any screen

¢ only one application window can be opened per screen

e child windows are maximized to fill all screen

¢ child windows do not have menus or panels, just live view mode

e double-click layouts and/or channels to load them in the main application window

e drag and drop layouts and/or channels from the main window list to extension monitors

The advanced window settings dialog box offers the following possibilities:

e create windows for the available displays and manage their properties
o assign default layouts and sequences to windows (local displays only)
¢ bind windows to video wall displays
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Advanced window settings

Yes

Window name [ start full screen

Startup display + Yideo wall momtor

Available video walls

er * Showroom

Set default layout

(Default)

»* Allow channel and map pop-ups [ Allow layout pop-ups

Advanced window configuration

In the upper part of the configuration dialog box you can see the available window list. The main Luxriot EVO
Monitor window (marked as Primary) is always present in the list and it cannot be deleted or renamed. More
windows can be added, their maximum number being limited to the number of displays physically connected to the
workstation. For each window, the following items are displayed in the summary list:

e display number

e primary or not (cannot be changed)

e startup layout/sequence, if set

¢ channel/map pop-ups allowed or not

¢ layout pop-ups allowed or not

e start fullscreen or not

e video wall screen number, if set

All these settings can be changed below.

To add a new window, click the + Add window button in the upper-left-hand corner (when the number of
windows has reached the number of physical displays, the button becomes grayed out). Select the parameters of the
new window and click Save for the changes to take effect.

) If you make some window a part of the video wall, the startup layout/sequence setting will be reset and
grayed out, as video wall startup settings should be defined in the video wall management tab.

©2024 A&H Software House. All Rights Reserved.
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9 Keyboards & Joysticks

Luxriot EVO Monitor offers a set of keyboard shortcuts for most interface controls and operations, and also gives
you the option to re-program every single key combination, allowing you to assign your own key combinations to
every available operation (action). This is true not only for the standard computer keyboards, but also for PTZ
keyboards and joystick controllers.

/& The controller device should be DirectShow compatible in order to be recognized in Luxriot EVO Monitor.

All keyboards connected to the Luxriot EVO Monitor station are automatically detected and listed as available for
shortcut configuration; the list of default shortcut mappings is also attached automatically, if it is available for the
target controller. For PTZ keyboards, joystick functionality is not listed but it is implied that all joysticks have the
same behavior, which includes pan and tilt on X and Y axes and zoom on Z axis. If you wish to calibrate your joystick
before using it in Luxriot EVO Monitor, please go to the Windows Control Panel and find your device under Devices
(Devices and Printers section).

) The list of available commands is the same for each connected controller and cover most of the actions that
can be performed in Luxriot EVO Monitor. Commands cannot be added to the list manually at user's will but it
is likely that the list of the available programmable actions will be expanded based on the customer feedback.

In order to view and edit the shortcuts, go to the Luxriot EVO Monitor main menu -> Edit -> Command mapping.

List of mapped commands

From the Devices drop-down list, choose the keyboard you wish to configure the shortcuts for; if your device is not
in the list, make sure that it is connected to the server and that its driver has been installed correctly. Some devices,
such as standard keyboards, have an extended pre-configured (default) set of command shortcuts covering almost
all the available actions; generic ones have either no default configuration or shortcuts for calling first ten presets of
a PTZ-capable camera.

In order to change shortcut mapping and replace it with your own key or key combination, simply double-click the
target command and enter your desired key combination from the keyboard. A minimum of one and a maximum of
four keys is expected for the standard keyboard, and a maximum of two keys - for PTZ keyboards or joysticks. If the
entered key or key combination is already used somewhere else, you will be prompted to either confirm the new
mapping or discard the changes and pick another shortcut.

Use the Load Defaults button in the bottom-left-hand corner if you wish to discard all changes for the currently
selected controller and load default configuration instead.

When you have finished with the shortcut configuration, click Save to confirm all changes and close the dialog box.

Quick Access Items
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As it is not possible to enter letters from the CCTV keyboard, you cannot search channels and other resources by
names. Instead, Luxriot EVO provides an option to assign numeric values to the server resources, thus enabling pure
numeric search in Luxriot EVO Monitor. Please contact your administrator to setup an option in %console%.

Quick Search

After configuring the quick access items, you can use the CCTV keyboard to put them on the workstation screens.
For this, press the Cam (Set) button on the keyboard: a dialog window will pop up, allowing you to enter [partial]
names, and search for and filter channels and other resources.

Window

Activate live Alarm live

Activate playback Alarm play

Start search in tree
Full screen AUX 1

Quick popup Cam (Set)

Load defaults

The quick popup command is bound to the Cam (Set) keyboard button by default
To simplify quick search, you can use filters:
Quick popup

Search Filter by

Ouick access Title 1

Quick access: search via Quick Access ID
Title: search by resource or item name
Id: search by global system ID

The popup logic is as follows:
o the viewport with the selection (yellow frame) is filled by the selected channel when the quick popup
command is activated
o if there is no selection, the first empty viewport on the primary screen is filled (including playback)

e to control where the next channel goes, move the selection (yellow frame) with the next/previous
screen/window buttons, then call the quick popup window, search for the channel by entering its quick
access ID and then confirming it
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Quick popup

Search Filter by

Quick access Title Id

Cancel

Use the search field to enter the quick access ID and the filters on the right to define the search scope

If necessary, use the filters in the top right corner to limit the search scope. These can be set with a mouse (define
the filters and then run the search once for the filter state to be saved).

Command Mapping

Many commands are already pre-bound for the keyboard buttons, and they can be re-assigned, if desired. The
joystick is used for PTZ.

To change the hotkey functions, go to the Luxriot EVO Monitor main menu Edit > Command mapping. Choose a
command, then press the button on the keyboard.

/. Consider that the Numpad is reserved for entering Unicode characters, so you can't map the hotkey
combinations to it.
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Command mapping

Devices

Panasonic VW-CU980

Map all screens Multi screen
Unmap all screens Clear
Save current layout

Select previous window

Select next window

Select previous screen

Select next screen

Toggle lock of current screen

Close current screen

Toggle maximization of current screen Preset
Execute user button of current screen

Toggle instant playback

Load defaults

Pre-mapped i-PRO keyboard commands
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Connecting to
Server. s

Mapping example: use the specified buttons to navigate in the Quick Popup dialog
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10 Viewport Overlay

Each grid cell n live view can be thought of as a 'slot' - a rectangular part of the layout - and it is called a
viewport. Every viewport can accept channel video, user buttons on top of the video, and maps/geo maps.

In addition to the picture itself, every viewport contains detailed information about the video stream, as well as
several quick controls and toggle buttons, including PTZ controls. These elements overlay the video stream,
meaning that the actual video does not contain them and they only exist as a part or GUI for enhanced user

interaction.

The main overlay items are briefly explained below. Also, you will find more details on some of the controls in
the Application settings and in the Video overlay sections.

Live View

The main view with live streams. Video streams will have the most overlay controls; some of them will also be
available for maps and webpages.

. : ¥ — [ il ]
3. A JPEG LIMP 10FPS 28.4 Mb/s ORI |

==
Selected viewport with an active live stream

The following overlay controls are available for live view:

e Upper-left: general viewport controls

X - close live stream and free viewport - available with or without viewport selection

viewport lock status: unlocked (default) or locked; unlocked means that the viewport can be
used for map/camera pop-up

camera name
user buttons, if assigned

e Upper-right: current time on the server from which the device originates (you can change this by going to
the main menu View > Time Presentation)

o Lower-left: stream details

recording status: X = not recording, yellow arrow = recording

motion detector status: running = motion present, standing still = no motion detected
video codec of the stream

picture resolution, abbreviated

stream frame rate, FPS

stream bitrate, KBytes/s or MBytes/s

e Lower-right: controls; toggled ON items are highlighted yellow

instant playback
PT7 tnoole: PTZ HITD and hattam nanel ON/OFF
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e DPTZ toggle
e motion grid ON/OFF
¢ incoming audio ON/OFF (if enabled and supported by camera/software integration)

e audio OUT: press and hold the microphone to speak (control is present only if the feature
supported by camera/software integration)

e substream: auto/main/substream

e aspect ratio (auto/stretch to fill viewport/original)

¢ notification panel toggle

* add bookmark

e snapshot export to library

¢ send channel to sequence explorer (overlay disabled by default)

¢ send channel to smart search (overlay disabled by default; will not appear for channels without
motion data)

e Bottom: PTZ controls

e Presets

e Tours

e HUD (Heads Up Display) ON/OFF
e Centre: PTZ HUD controls

e Pan and tilt arrows

e Zoom slider

e Iris slider

e Focus slider

You can choose which ones appear by going to the application settings. Some of the controls may not appear
because the related functionality is not available or not supported by the integration (e.g., audio, PTZ); the controls
are also subject to the user permissions. For instance, if you do not have permissions to access the channel's archive,
the instant playback button will not appear.

' The overlay control set may vary depending on device capabilities and settings. For example:

if no archive is recorded for the target stream, instant playback will not be available

e smart search switch will only be available with recorded channels with motion detector data
e for PTZ-incapable cameras, PTZ toggle will be absent

e substream toggle will not be displayed when device only has one stream

e audio OUT will not be displayed if this feature is not supported by camera or is not implemented on
the software side etc.

Overlay elements can be modified in Application Settings, which are reachable via main menu by clicking Edit ->
Settings. Note that overlay parameters are defined for the whole application and cannot be set separately for the
application windows and/or individual displays.

Notification Pane
Live view has its own notification panel for each channel, which can be turned ON and OFF by using the

notification panel toggle control in the bottom-right-hand corner of each viewport. It contains:

e live events from E&A and from external services, e.g., LPR and facial recognition results, and

e recent stream errors, e.g., PTZ related errors, which have occurred since the time the channel was opened
for live view.
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/1872016 1 PM

A connection attempt failed because the connected
party did not properly respond after a penod of time, or
established connection failed because connected host
has failed to respond

i5 PN
A connection attempt failed because the connected
party did not properly respond after a pericd of time, or
established connection failed because connected host
has failed to respond

 PM

A connection attempt failed because the connected
party did not properly respond after a period of time, or
established connection failed because connected host

has failed to respond

A connection attempt failed because the connected
party did not properly respond after a penod of time, or
established connection failed because connected host
has failed to respond

PM
A connection attempt failed because the connected

Notification panel containing errors for a disconnected stream

You can change the size and position of the notification pane. To do this, long press your left mouse key on the panel
(in any place): a header and a pencil icon will appear on top of the panel. Click the pencil icon to enter to editing

mode.

©2024 A&H Software House. All Rights Reserved.

44



Luxriot EVO Monitor User Guide

X m' FR masks

)

Position and size
Modified

3§ H264 FullHD 25FPS 1.9 Mb/s ORI /I W O]

Edit the notification panel appearance: size, position, and contents size
You have several adjustments to make here:

e click and drag the yellow frame to change the panel size
e drag and drop the panel to move it within the viewport
¢ change the Scale setting to make the pane contents smaller or larger
The status below will show if the panel is currently in its original state (default) or has been customized (modified).

Click Done to save the changes, or click Reset to revert the changes to the default appearance. Double-clicking
outside the panel will also apply the changes (similar to Done button).

The notification panel is only available in the live view. If you keep it in the ON state while saving a layout, the panel
will pop up automatically for the target channel next time you open the layout, i.e., the panel state is saved with
the layout.
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Viewport switching in Live view and Playback modes

You can switch between expanded Viewports or in a Single Viewport Layout by moving mouse to the left or right
part of the Viewport until the Arrow overlay button appears. By clicking the Arrow button you will switch between
the next or the previous Channel, so there is no need to return to the multi-viewport layout. You can disable the
Arrow button overlay with the right mouse click.

= Connection (1 servers)  File  Edit

Search

™ Layouts
ol =|
= ayout sequences

¥ B Layout templates

T Channels

Loc
E|' Hiki
= iPrRO

@ Maps

The Single viewport control expample
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Instant Playback

Overlay elements in the instant playback mode are different from those in live view.
w Feline Street giis ~ g 2

Instant playback in a live mode viewport
The following overlay controls are available in the instant playback mode:

e Upper left:
e X - close live stream and free viewport

e viewport lock status: unlocked (default) or locked; unlocked means that the viewport can be
used for map/camera pop-up and may therefore be replaced by other camera at any moment

e camera name
e Upper right:

e timestamp (its appearance can be configured via application settings)
e Centre: play/pause

o click to play

e click again or drag to the centre of the line to pause

e drag right to go fast forward

e drag left to rewind fast

o click and hold on the left/right side to change the playback direction

¢ release from dragging to continue normal playback
e Bottom right: controls

e switch to multichannel playback

e go to specific time

¢ toggle motion grid

e switch to advanced playback (off by default)

e take control (for interactive channels)

e create a bookmark with current timestamp

e take a snapshot

e automatically export current piece of the footage
e Bottom: timeline

o click any place of the timeline to switch to that point in time

e use the <> arrows to adjust the loaded footage time boundaries (which, by default, are the last
five minutes)

e drag right to go forward in time
e drag left to go backwards in time
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e the vertical yellow line indicates current playback moment, drag it anywhere or click to move
along the timeline

Sequence Explorer
Once you have selected a fragment or a set of fragments, the overlay controls in the bottom right corner of the

selection offer the following possible actions:

e Magnifier button: make a new sequence out of selected fragments; use the History controls <> in the
upper panel to go back

e Play button: play selected footage in archive playback mode

¢ Video button: export video from the selected time range (no additional Set time range window is
displayed)

More detailed control and operation descriptions for the sequence explorer can be found here.
Text Overlay From Data Sources

Textual data from external data sources, if configured, will appear embedded with the live video stream.

X b Till#4

HRckRk kR

MY SHOP

1199 Monexistent Stree
New York, NY

VISA iH8HHH13528

Total: $49.85

APPROVED
THANK YOU
CUSTOMER COPY

S A ARG

Live video stream with text overlay
Metadata Overlay

Bounding boxes with object properties will appear in the video if video analytics is enabled for the target channel.
This may be server-side video analytics (VA) or Open VCA. Also, VCA metadata are supported for some of the
cameras.

You can change the metadata overlay via Application settings.
Channel Shortcuts aka Portals

Channel shortcuts, if pre-configured in Luxriot EVO Console, appear in live view and in playback as video overlay
elements. Single-clicking these will pop up the target video channel in the same viewport.

=

‘s Channel shortcuts were added to Playback mode starting with the software version 1.24.
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Shortcuts to other channels in live view

Read more about visual links in the Video overlay section.
Maps

Maps and geo maps have general overlay controls in the upper left corner:

e X - close the map and free viewport - available with or without viewport selection
o viewport lock status: unlocked (default) or locked; unlocked means that the viewport can be used for
map/camera pop-up
e map name
Every map also has interactive markers (per-configured in Luxriot EVO Console):
¢ double-clicking channels* makes them pop-up in the first available viewport (either empty or the first
non-locked one)
e maps* links will make the target map pop up in the same viewport
e layouts* will also pop up and replace the current layout or layout sequence
¢ double-clicking user buttons will trigger actions, which are associated with them
e click a door marker to see the list of available actions
*Remember that every Luxriot EVO Monitor window can be set to accept either individual map/channel pop-ups or

layout pop-ups, but not both. This can be changed in the multidisplay setup. Also, you can change the interaction
mode from double-click to single-click in the Application settings.

Watermark Video Overlays

The Luxriot EVO system supports visible video watermarking to help ensure data protection. If your system
administrator has enabled the watermark, you will see a watermark overlay over all viewports with the video
streams in both Live View and Playback modes. The watermark is based on the unique user ID, and can only be
disabled by the Luxriot EVO server administrator.
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™ Observing *

Documentation

All available documentation for
security and video surveillance software

available here:

SEE ALSO

-

lay over viewports with the video streams

Example of the Watermark over
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11 Substreams

Substream is a lower resolution video used for reducing Luxriot EVO Monitor PC resource usage (CPU, network) for
live view display. Also, it is possible to play back secondary streams instead of high resolution video on low
bandwidth connections. For example: main stream for recording can be set to 1920x1080 at 30fps and substream -
to 640x480 at 15fps, which would provide much lower load for Luxriot EVO Monitor PC to display video stream.
This allows to have high quality recordings combined with the ability to view many video streams on a low-
performance Luxriot EVO Monitor PC and with limited bandwidth.

Both streams are available for live view and for recording (the latter is configured via Luxriot EVO Console). The live
stream selection is configured to Auto by default, which means automatic switching between higher/lower
resolution streams depending on the image size in order to save network and CPU resources. For instance, Luxriot
EVO Monitor may show a high-resolution stream if you view one camera at a time, but if you go to 4x4 view, Luxriot
EVO Monitor will automatically switch all the cameras to substreams, if they are available. In multi-channel views,
the application compares each viewport size to resolutions of both channel streams and decides, which one is better,
based on similarity to the output viewport size.

Luxriot EVO Monitor application has the following visual indication for substreams in live view as a viewport
overlay item (bottom right):

[ |
> Al @ N | | o
Automatic selection between high and low resolution (based on viewport size)

> ~Z A B

Fa ﬂ
ﬁ.
Low quality picture (substream)

High quality picture

When no substream is available, the viewport overlay indicator simply will not appear at all for the target channel.

Substreams must be activated on your device via Web browser and, for some devices, this can be also done in the
stream properties in Luxriot EVO Console. Please verify camera performance to make sure substream can be
handled by the camera along with the other enabled features: some devices tend to drop the overall FPS with

the second stream turned ON.

Most cameras provide the second stream as a primary stream image scaled to fit the low resolution. However, some
devices crop the centre of a high-resolution image to fit the smaller frame, and thus the substream picture appears
as if it were zoomed in. Keep this in mind when you are using substream for live view and especially for software-
side motion detector analysis.

If both main and secondary streams are configured for recording, the target channel will be expandable in
playback mode and will have both tracks available for playback.

- x: Park Gate

Kl Primary

3 Sybstream

Substream footage in playback mode
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12 Channels

Channels are resources that contain video data from the Luxriot EVO server. Depending on the channel capabilities
and configuration, each channel may consist of main video stream (hi-res), secondary video stream (substream, lo-
res), audio, motion and video analytics metadata, text from configured data sources (e.g., POS transactions), and
external service data (e.g., facial recognitions).

All channels from the connected servers are listed in the Channels section of the Resources section on the left. If the
server connection has the Merge resources option ON, all resources will be shown together without per-server
grouping. Note that the channels are displayed according to the logged user privileges.

T Channels

- Local Server

T Wv-58574L 3

" Wy-58574L 4

Server #2

Channel section example

Cameras connected in a Passive mode will be shown in a "light-green" color . To review streams from Passive
cameras you need to add the Channel to the Viewport. Removing the camera from the Viewport will turn it back to
the Passive mode.

Channels are loaded with visual groups, if there are any; otherwise, they are simply listed under the relevant server
name. You can create any hierarchy of visual groups and define their contents via Luxriot EVO Console. Use the
Search filed above the channel list to quickly find a specific channel.

Double-click or drag and drop desired channels onto the layout viewports on the main live/playback window to view
stream contents. For secondary displays, use drag and drop method only.

When you double-click channels in live/playback view, they fill viewports in the following manner:

o first, all the empty viewports are filled - from top to bottom, and from left to right;
o then, the filling sequence starts again from the very first viewport.

To remove any channel from live view, click the overlay control X button next to the camera name in the upper-left-
hand corner of the viewport.

Crosslink Channels

Crosslinks are a special case of channels. It provide interactive and non-interactive website contents packed as
video for both live streaming and playback. You can use them for monitoring web services with UI and dynamic
contents. Read more about different kinds of webpages in Luxriot EVO Monitor here.
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Live streaming from a website

To display the Crosslink channel in the Luxriot EVO Monitor application, locate it in the channel list on the left, then
double-click (to pop it up on the first free viewport) or drag and drop it onto the desired viewport.

Crosslinks possess some of the regular channels' properties. For each one, you will see stream properties (bitrate,
resolution, frame rate, recording status), and also have overlay buttons for controlling aspect ratio, applying digital
zoom, adding bookmarks, and creating snapshots. If the Crosslink stream is set to be recorded, you will be able to
access the recordings in the playback and instant playback modes.

Apart from Crosslink channels, there are also non-recordable (direct) webpages. You will find these it the Crosslink
(Webpages) section of the Resources panel.
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13  PTZ

For PTZ-enabled cameras, pan, tilt and zoom controls are available both for live mode. Note that available controls
may depend on selected model and actual camera capabilities.

PTZ control is available in two flavors: HUD and classic PTZ sphere, with HUD enabled by default. Classic virtual
PTZ sphere controls can be turned ON via application settings as described below.

" When two or more simultaneous PTZ command requests (either from an action or from direct user input) are
sent at the same time, PTZ priority parameter is used to decide who gains access first. When this happens,
request with a higher priority is fulfilled while request with a lower priority is delayed for ten seconds. If after
ten seconds the higher-priority action is still going on, the lower-priority action is denied PTZ access for ten
more seconds and so on.

If two users or actions with the same PTZ priority level have an access conflict, they will be both granted PTZ
access simultaneously and the order of executed PTZ commands is defined by which of the commands reaches
the device first.

Default PTZ priority for all users, including those built-in and imported, and also for all actions is equal to five
(medium priority). You can assign any user/action a higher PTZ priority (six to ten) or a lower one (four to
zero) by editing individual user/action properties in Luxriot EVO Console. The only exception is the PTZ
tours, which by default have the lowest priority (equal to zero), which means that any user or action can
intercept PTZ control; the tour will go on after the PTZ control from a higher-priority user/action is released.

PTZ control is carried out using the HUD overlay controls or point-to-PTZ style controlling without overlay
elements; it is automatically enabled if the camera has PTZ facilities.

e If HUD or classic sphere is enabled, use the overlay PTZ sphere to control camera movement: click and
hold to move the camera up/down, left/right or diagonally; additional controls allow to adjust the
camera's iris and focus, as well as to zoom IN/OUT;

e If visual PTZ controls are not enabled, click anywhere on the picture to re-position the camera using
indicated point as a new picture centre (point-to-click style).

) When re-positioning a PTZ camera, note that some cameras may have response delay due to heavy device
load, physical distance, network latency etc. Bear this delay in mind when using PTZ and, if necessary, release
the virtual PTZ sphere controls earlier.

Switching Between PTZ Control Styles

By default, HUD style viewport overlay controls are used for PTZ. You can change this by going to the main menu
Edit -> Settings and choosing the Viewport overlays tab -> PTZ Controls section.
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General

PTZ Controls
Viewport overlays

Library

PTZ Centrols (Manipulation)

Snapshots export
PTZ Heads Up Display (HUD)
Video export

Inis Shder
Sounds

Focus Slider

Zoom Slider

PTZ Toolbar

Classic Ptz Overlay

Manage PTZ overlay control settings
You can toggle between two modes:

e PTZ Heads Up Display (HUD): on-screen controls overlaying video stream
¢ Classic PTZ Overlay: virtual PTZ sphere with traditional design
¢ Point-to-click: Control camera with the mouse
One of the two modes can be selected at a time and the selected mode will be activated when you enable PTZ for the

channel of your choice. Either visual control set can be hidden by clicking the HUD button in the bottom right
corner of the viewport; in this case, PTZ can still be controlled by clicking the live video stream.

Heads Up Display (HUD) Mode

The following controls are available in HUD mode:

e Pan and tilt arrows

e Zoom slider*

o Iris slider*

e Focus slider*

¢ Automatic focus/iris* (J§ button on the lower slider end)
e Presets and tours

e HUD (Heads Up Display) ON/OFF

*Note that some of the additional controls may be unavailable depending on the device integration and capabilities.
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X Vivotek PZ7131 on 192.168.3.19
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Live view with enabled PTZ and HUD overlay controls
Use the bottom overlay menu for presets, tours and HUD ON/OFF switching.

Classic Virtual PTZ Mode

For users who prefer classic appearance of PTZ controls, an alternatively looking panel is offered. It also overlays the
live view, and is docked to the top left corner of the stream. Classic PTZ sphere has the same capabilities as the HUD
sphere. Apart from pan and tilt buttons on the sphere, zoom, focus, and iris sliders will appear, if the related
functionality is available on the device.
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Live view with enabled classic PTZ sphere
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Point-to-click PTZ mode

You also can control compatible cameras PTZ with mouse by selecting Point-to click PTZ controls inside viewport.
16:45:59
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PRESETS « | | TOURS Sw P HuD

Point-to-click PTZ control

/. Point-to-click PTZ controls currently available only with compatible devices connected to the VMS using
ONVIF Compatible driver.

Presets

Click Presets below the picture to view the list of available presets; select any to let camera go to the selected pre-
defined position. To save a preset, adjust the camera position using PTZ controls, then click Presets and choose
Save preset. Enter user-friendly name for your preset and pick a preset to be re-defined from existing preset list,
then click Save.

Note that PTZ presets cannot be explicitly deleted: to remove an old entry, simply replace it with a new one.
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Save PT/Z preset

Preset siot #

Preset #2

PTZ preset name

Cente red

Enter preset title and choose slot
Tours

Multiple PTZ presets can be combined to create a preset tour - a series of positions for a PTZ camera to go to
through repeatedly. Each preset in a tour can be assigned a duration period of its own.

Click Tours below the picture and select Create tour to make a new sequence. Before building a tour, make sure you
have created all presets that will be used in the target tour.

) Tours are stored on the server and thus are synchronized between different Luxriot EVO Monitor workstations
connected to the same server.

Create tour..

3 g H2es Deactivate tour

PRESETS = TOURS =

Choose to create a new tour

Add and remove presets by double-clicking them; newly added presets will appear at the end of the tour preset
list. You can also use Search field to quickly find your desired preset, and the recycle bin icon in the upper-right-
hand corner allows you to remove a selected preset from the target tour.
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New P1/Z tour

Presets tour

Preset #1 Preset #1
Preset #2 Preset #4
Preset #3 Preset #7
Preset #4 Preset #8
Preset #5

Preset #6 Tour name

Preset #7 | I

Preset #8 " Autostart

Preset #9 Sequence starts automatically on serve

Create a new tour

Click a tour preset to change its delay time. By default, each preset has a pause of five seconds, and you can change
that to whatever time period you wish for the camera to continue overlooking that specific position. Next, define a
title for the target tour and enable automatic start, if desired; if you select autostart, the sequence will be launched
immediately after server start.

When you have finished, click Save to add your newly created tour to the list of available tours.

® Vivotek PZ7131 on 192.168.3.19 s

Z00M

Edit tour...
i g Create tour...

Remove tour
'i" MPEG4 Deactivate tour s

PRESETS = TOURS =

Tour options

To start a tour, click Tours and simply select the one you want from the list; to stop it, click Deactivate tour. Each
tour options - Edit and Delete - can be accessed via the n button next to the tour name.
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14  Digital PTZ and Dewarp

Digital PTZ

Digital pan-tilt-zoom (DPTZ) can be enabled for both PTZ and non-PTZ cameras. This feature provides image
magnification by the means of cropping and enlarging the picture, additionally using the picture-in-picture feature
to display a preview of the whole stream when the original picture is zoomed IN. While it is mostly useful for devices
without optical zoom capabilities, if you do not wish to grant some of your users PTZ control access, then DPTZ can
be also used for PTZ devices. Also, digital zoom can be used for maps.

' Last used digital PTZ position is preserved when you save a layout containing a zoomed stream or map.

In order to enable DPTZ in live view or playback, select the target viewport and enable digital zoom by clicking

DPTZ toggle ﬂ button on the overlay control panel in the bottom right corner. You can also set DPTZ controls to
be visible by default via Luxriot EVO Monitor main menu Edit -> Settings -> Viewport Overlays tab.
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Live view with DPTZ controls enabled

An additional panel with DPTZ controls will appear below the video stream. To use DPTZ with maps, simply use
your mouse wheel to zoom IN and OUT and then drag to view different parts of the map.

DPTZ and dewarp positions will be preserved when you export a snapshot.
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Digital PTZ Modes

Digital PTZ for video streams has two modes:

e region
e draw a rectangle on the video by left-clicking and dragging with your mouse

e when you release the mouse, the marked area will be automatically zoomed in and a small
preview window (picture-in-picture) will appear in the upper left corner of the video

e move the selection in the preview window to view different areas
¢ use the mouse wheel either in the preview or in the original video to zoom IN/OUT
¢ PTZ imitation

e zoom IN/OUT by using your mouse wheel

e when the picture is zoomed IN, a small preview window will appear in the upper left corner of
the video

e move the selection in the preview window to view different areas

¢ additionally, you can move around the video by clicking the original video as if it were a PTZ
camera (click and hold to move in that direction)

The basic difference between the two modes is the method of moving around the picture: either by drawing new
regions or with PTZ Point-to-Click imitation. By default, the region mode is enabled, and you can switch between
the two using the buttons on the right side of the DPTZ panel (RGN for region and PTZ for point-to-click mode,
correspondingly).

DPTZ Presets

Digital PTZ positions can be saved as presets and then called later at any time, just like regular PTZ presets. Use the
Presets drop-down list in the left part of the DPTZ panel for this:

e to save the preset, click the arrow and click Save preset, then choose whether you want to create a new
preset or overwrite an existing one, specify the preset name and click Save
o click the preset name in the list to load it
e click the ... button next to the preset name and choose Remove preset to delete it
Digital PTZ presets are stored locally, on the Luxriot EVO Monitor application side, and are bound to channels. This

means that, once created, DPTZ presets will be available for the target channel from the same workstation and they
cannot be shared with other application instances connected to the same server from other places.

Dewarp

For cameras with fisheye and Panomorph lenses, dewarp mode is enabled when digital PTZ is turned ON. This

feature can be used both in live view and playback mode; in order to use it, click the DPTZ toggle ﬂ overlay
control in the bottom-right-hand-corner of the viewport.

By default, region dewarp mode is turned ON: a part of the dewarped image is displayed in the viewport and
camera becomes a virtual PTZ, which can be zoomed and moved through the entire angle that fisheye camera allows.
Press left mouse button and drag to pan/tilt in corresponding direction; use the zoom slider to zoom in and out.

You can place one channel into multiple viewports on your viewport layout, enable DPTZ for all of them and then
use DPTZ to display different regions of the dewarped image. The created arrangement can be saved just as usual,
via Save Layout menu in the upper-left-hand corner: DPTZ positions will be maintained when you load the layout at
any time later.

Regicn

180° Panorama

360° Panorama

MODES =

Choose dewarp mode from the drop-down list
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If you need a larger part of the scene to be displayed in a single viewport, you can switch to a 180-degree or a 360-
degree panorama view using the drop-down menu, which appears in the bottom of the viewport when DPTZ is
enabled.

' Ifyou do not have a dewarped picture after enabling digital PTZ capabilities, it means that dewarp has not
been configured for the target device. In order to do this, go to Luxriot EVO Console and adjust dewarp
settings in the channel properties; the details about setup are available in your Luxriot EVO server
management documentation.

©2024 A&H Software House. All Rights Reserved.
62



Luxriot EVO Monitor User Guide

15 Audio

Using Luxriot EVO Monitor application, you can listen to audio streams from cameras, play back recorded audio, as
well as talk back to the cameras. Recorded audio streams are also available when you export the recordings.

Two-way audio is also supported for the Luxriot EVO Mobile application; please refer to the mobile application user
guide.

' In order audio stream to be available in Luxriot EVO Monitor, there are a few conditions:

o the device, from which your selected channel originates, must be capable of sending/receiving audio
and this feature must be enabled and set to G.711 codec via device Web interface.

o the device, from which your selected channel originates, must have audio support implemented in
Luxriot EVO; please contact Luxriot if you have doubts.

¢ audio function must be enabled for the target channel via Luxriot EVO Console, please check the
settings via Luxriot EVO Console according to the Audio section of the Luxriot EVO administration
user guide.

Without these, audio IN/OUT controls will not be available for the selected channel.

/. Make sure that the speakers and the microphone on your workstation are properly installed and are operable
in order to be able to use the audio functionality in Luxriot EVO Monitor.

Live View

Audio IN/OUT toggle overlay controls are enabled by default for the live view and become available when you select
a viewport by clicking on it. You can change this preference via Luxriot EVO Monitor main menu by going to Edit ->
Settings: you will find the related settings in the Display controls section of the Viewport overlays tab. The available
display options are: always show the overlay control, show only if the viewport is selected and disable the overlay
control.

X 4 IPEG HD720 20FPS 677.2K/S

Audio overlay controls in Live view
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By default, live audio is OFF; in order to listen to the incoming audio, click the speaker overlay control so that it
becomes yellow: if audio functionality has been enabled on the device side and in Luxriot EVO Console, you should
be able to hear the sound coming from the target device.

In order to send some audio back to the camera, press and hold the microphone overlay control (it will also turn
yellow, indicating that reverse audio is active) to speak, then release the control when you have finished speaking.

Playback

If a channel has incoming audio recording enabled, it will be displayed in the archive playback mode. On the
timeline, recorded audio is denoted by a blue line, which slightly wider than the white line (video stream) and the
cyan line (motion).

|4 244 -1 -10m -1m -105 ] h Ip =105 <im0 +10M +1H 2244 P —— e ——— (oW Ol > |

Audio in playback mode is displayed as a wide blue line

By default, audio is muted; in order to enable it, select your desired channel simply by clicking on the picture
(viewport) and then use the speaker overlay control to turn audio ON. Note that the overlay control will only be
available if there is some recorded audio for the selected channel. Then, start playing back the recordings as usual to
play both video and audio streams. Use your Windows volume mixer to adjust the sound volume.

©2024 A&H Software House. All Rights Reserved.

64



Luxriot EVO Monitor User Guide

16  Motion Overlay

Click on your desired viewport and use the motion icon control in the bottom right corner to switch the motion grid
overlay ON and OFF. This will only work if motion detection is enabled for the selected channel.

® Vivotek PZ7131 on 192.168.3.15
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Live view with motion overlay on a channel with software motion detector enabled

If the motion detector is turned ON for the channel, you will be able to generate motion frequency heatmaps via
Reports tab.
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17 Instant Playback

Interactive live view mode gives you the opportunity to browse the archive right in the same viewport, without
having to switch to the playback mode. This allows you to view recent footage for selected channels, while still
having live view displayed for other devices. By default, footage is loaded for the previous five minutes and the
playback starts five seconds before the current moment; use the <> timeline boundary controls to change time
range by clicking and dragging mouse to the right (zoom in) and to the left (zoom out) of the <> arrows.

) This mode is only available for channels that have recording enabled.

To enable instant archive playback, use the Play button overlay control in the bottom right corner of the live
viewport. The channel will automatically switch to playback mode, allowing you to select timestamps, create
bookmarks and export snapshots/video clips. To exit instant playback mode, use X in the overlay controls' bottom

right section.

Instant playback mode can be enabled for one, multiple or all viewports in the current layout: you can switch
between live and instant playback viewports without any limitations. This archive presentation mode is also used
when investigating data from external services and from data sources in the corresponding Luxriot EVO Monitor
tabs.

Instant playback mode

©2024 A&H Software House. All Rights Reserved.

66



Luxriot EVO Monitor User Guide

The following overlay controls are available in the instant playback mode:

e Upper left:
e X - close the stream and free viewport

o viewport lock status: unlocked (default) or locked; unlocked means that the viewport can be
used for map/camera pop-up and may therefore be replaced by other camera at any moment

e camera name
¢ Centre: play/pause
click to play, click any place in the viewport to pause/play (like on Youtube)
drag to the centre of the line to pause
drag right to go fast forward
drag left to rewind fast
e release from dragging to continue normal playback
e Bottom right: controls
e Play button: switch to regular multichannel playback (current layout will be used)
e go to a specific time (keyboard shortcut: Space)
e create a bookmark with current timestamp
e take a snapshot
o export loaded footage as a video clip (current timeline boundaries will be used)

¢ Bottom: timeline
e use your mouse wheel to zoom the timeline in and out (mouse position will be used as centre)

e use the <> arrows to adjust the loaded archive time boundaries (which, by default, are the last
five minutes)

e drag right to go forward in time
e drag left to go backwards in time

o the vertical yellow line indicates current playback moment, drag it anywhere or click to
move along the timeline

o the narrow white horizontal line shows recorded video

e the cyan line (a little bit wider than the white one) indicates motion

o the blue line (a little bit wider than the cyan one) shows recorded incoming audio

o the wide transparent white line denotes VCA metadata

¢ bookmarks look like little colored flags on the timeline, color depending on the severity level

Instant playback mode has two configurable settings: default duration and rewind time:

o default timeline duration is the interval size for the footage presented in the instant playback mode,
default: five minutes (300 seconds)

¢ rewind is the amount of time for the playback to jump back before "now" (the moment when the instant
playback mode was enabled), default: five seconds

Both values can be changed via Luxriot EVO Monitor Application Settings.
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18 Layouts

Layout is a pre-configured viewport configuration with channels assigned for live view and archive playback.
Layouts are created by filling a layout template with video channels. There are two main groups of layouts: local and
shared.

Local layouts are created and stored locally on the same computer where the Luxriot EVO Monitor is installed; these
are not available for other machines connected to the same server. However, local layouts can be exported and
then used on other workstations: to do this, simply select Local resources when exporting application settings via
main menu Tools > Export Settings.

Shared, server-side layouts are kept on each server and are available for all users that are connected to the same
server from other client computers. If the license limits the client connection number to 1, layouts can still be shared
between non-concurrent client connections from different machines.

Layout template is a grid-like viewport pattern without any channels bound to it. There is a set of default layout
templates stored locally with each Luxriot EVO Monitor installation; also, user-defined custom templates can be
created via Luxriot EVO Console. Layout template with the channels assigned to viewports can be saved as a layout.

£2% Layouts

» = Local
[& Layout sequences
» B Layout templates
™ Beach Hotel
M. (fain
* = Server #1
» B Layout templates

B Boach Hotel - Main

Layouts section

Drag and drop your desired layout template from the Resources menu on the left - either from the default local
templates or from pre-configured layout templates available under connected server. Template will be empty; drag
and drop channels from the relevant section of the menu on the left onto the layout viewports to fill the grid with
cameras. Channels' contents will be loaded automatically if it is available. You can also use maps and webpages in
any layout.

Click the layout menu E button in the upper-right-hand corner - just above the layout - and select Save Layout
to save channel configuration as a new local or shared layout, or to overwrite any of the existing ones.
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Save layout Save layout

Save as

Layout title

1st Floor Lounge
Layout title

New Layout

[ Save presets

[ Shared
1st Floor

Save layout: regular or shared
There are the following additional options:

e Choose Save Presets if you wish to save the last activated preset for a PTZ capable camera together with
the layout. If you do, the preset that was used for the PTZ camera will be remembered and loaded together
with the layout, overriding any PTZ position changes, which have been made by any other user/action.

e To make the newly created layout available to any user connected to the same server, enable the Shared
option in the layout properties and choose your desired settings: target server and layout group. Users who
have the View permission for the target layout group will be able to see and use your layout; users with the
Administer permission will be able to overwrite your layout using the same name.

Click the Expand [lIf} button next to the local layout name in the Resources list to remove the layout.

! You need at least one layout group to exist on the target server for you to be able to create shared layouts.
Also, your currently logged user must have permissions to administer the target layout group.

In order to add layout groups, log into the target server via Luxriot EVO Console under an administrative
account and go to Layouts section; details are available in your server administration user guide. Note that
there are no built-in layout groups.

Together with the layout, the following parameters are saved and loaded for each viewport, both for local and
shared layouts:

e channel/map/webpage position within the layout template

o digital PTZ position

e aspect ratio

¢ notification panel

e PTZ preset (if enabled when saving PTZ)

The layout menu also allows you to send the currently displayed layout to any of the pre-configured video wall

components. Click the layout menu E button in the upper-right-hand corner and select Display on and then
choose desired video wall and target display number.
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Display on F Videowall *»

Click the Expand [ button next to any layout in the list to bring up the layout menu. From here, you can:

¢ delete the target layout, or
e send the target layout to the video wall screen.

Note that created layouts cannot be edited: if you wish to change the layout contents, load current layout contents by

dragging and dropping it on the live view, make desired alterations and then overwrite existing layout by saving the
current layout under the same name.
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19 Layout Sequences

Multiple layouts can be organized and saved as dynamic sequences, i.e. 'layout slideshows'. Each sequence consists
of two or more successive layouts, either local or shared. Each layout can be set to stay on the screen for a certain
amount of time.

Saved sequences can be exported into a file via main application menu Tools -> Export Settings and then loaded on
other workstations via Tools > Import Settings by selecting the Local Resources option.

To create a sequence, click the [[Ell button near Layout sequences in the resource explorer on the left.

22z Layouts

v [ Local

= Layout sequences

» [E Layout templates

Layout Sequences

The Create sequence dialog box will appear.

New Layout sequence

Layouts

al * 2nd Floor Local Server * 1st Floor Lounge
ocal * 3rd Floor ocal * 2nd Floor
* Reception Local * 3rd Floor
al * Park Local * Entrances
Loeal * Entrances

wer * 1st Floor Lounge

5E::1 uence name

| Quick Eifan |

New layout sequence dialog box

Double-click layouts or drag and drop them to add/remove layouts to/from the sequence. For each layout, the
pause time can be specified separately, with the default layout duration being 15 seconds. You can add each layout
once or multiple times to appear in the sequence. If necessary, use the Search field in the upper-left-hand corner to
find a layout by name. It is possible to use both local and shared layouts.

Enter a name for the new sequence and then click Save. The sequence will appear in the resource explorer under
Layout sequences; drag and drop it onto the view area of any window or double-click the name to activate it for the
main application window. The sequence will then start automatically; sequence controls will appear above the
viewports, allowing you to switch between layouts manually and play/pause; also, the panel will also show the
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remaining time for the layout that is currently displayed. If there is no connection to the server and shared layouts
cannot be loaded, the message on the panel will say "Retrieving layouts"; as soon as the connection is established,
the target layout(s) will be displayed.

M Il M Quick View (Local > Park 360%)

Sequence controls in Live view

Click the |< and >| arrows to switch to the previous/next layout immediately; use the pause button to terminate
playing.

To edit a sequence, click the [l button near the sequence name in the resource explorer and select Edit sequence;
to remove it from Luxriot EVO Monitor configuration, select Delete sequence. Note that if you delete or modify the
contents of the sequence currently being played, this will not affect current layout slideshow; in order to start the
updated sequence version, simply start it again.

Startup Sequence

Any sequence can be set to start automatically when the Luxriot EVO Monitor application is launched. There are two
available setup options:

o for local displays, the startup sequences are defined in the Multidisplay setup

e for video wall displays in Luxriot EVO Global, the local startup option is disabled, and the startup
sequence should be assigned via video wall management

To assign a startup sequence to a local display: while in Live view, click the Multidisplay setup button in the top
right corner, then click Advanced to bring up the settings. Select the target window in the list, then choose your
desired sequence from the drop-down list.

Startup display

1

Set startup layout or sequence
Shared layouts - seq Il

Any existing layout or sequence can be set as startup item

Luxriot EVO Global servers also have a video wall feature. In the same dialog box, you have a possibility to assign
any display to be a video wall screen. If you do so, the startup layout/sequence setting will be discarded and
disabled; to assign a startup item for the video wall display, switch to the Video Wall tab of the Luxriot EVO
Monitor application.

First, select the video wall from the resources panel either by double-clicking it in the Resources panel, or by
dragging it from the list onto the upper frame. The video wall thumbnail will appear: click the display you want to
set the startup item for and its current contents will appear below.

Drag and drop your desired layout sequence onto the bottom screen part: the sequence will be placed on the video

wall screen immediately and you will see a preview. Then, click the menu icon E on the upper right corner of the
preview and choose Set current layout sequence as startup.
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Set cumrent layout sequence as startup

Stop layout sequence

Next time the Luxriot EVO Monitor application is started on the target video wall display, your selected sequence
will start playing automatically. To stop it, select Stop layout sequence from the same menu.
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20 Maps

Maps and geo maps configured via Luxriot EVO Console can be viewed in Luxriot EVO Monitor: simply drag and
drop them from the resources list on the left to any viewport or use drag and drop to load them in the main
application window in live or playback mode. Maps fill the viewports just like channels but, unlike channels, they do
not have any footage. One map can be opened in one viewport or in many simultaneously.

Note that this resource type is not available for the free server license.

Map list in the Luxriot EVO Monitor

Maps inside viewports can be digitally zoomed IN and OUT with the mouse wheel and moved around using the left
mouse button (click and drag to move). Double-click inside any viewport with a map to switch to single camera view,
then click again to return to the layout view. Zoom level is preserved when you save the layout with the target map.
The same applies to geo maps, except when a geo map has been locked via Luxriot EVO Console: in this case, you
will only see one section of the geographical map, without an option to move or zoom it.

Both maps and geo maps contain interactive (clickable) contents. These may be channel markers, as well as other
items (described below). You can specify the desired interaction mode via application settings, choosing between
single and double click (you will fin these under main app menu > Edit > Settings > Usability).

A map with live channel thumbnail in the Luxriot EVO Monitor viewport

Channel markers produce live video preview when you hover your mouse cursor over them. Double-click the
channel marker to open the target channel in the first available viewport (either empty or unlocked), or drag and
drop to place the video in an arbitrary viewport. This functionality is not available in the playback mode.

In the archive playback mode, the map will only reflect markers for the channels that are currently present in the
layout. When a map is maximized (double-clicked to enlarge in a single viewport), all markers will still be present
but playback will be unavailable because there is no video on the screen. Current playback will be paused. Return to
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the multi-viewport view by double-clicking the map again to resume playback.

Channel Popup

Any channel shown on a map can be loaded in Luxriot EVO Monitor with a simple double-click (or single click, if
you have change the setting). In order to pop up a single channel from the map:

e hover your mouse over the desired device on the map until it becomes highlighted with a pink circle

¢ double-click the target device in order to map it automatically on the first non-locked viewport within the
current layout

¢ change the viewport, drag and drop your desired channel by its title onto to viewport of your choice
o if the device stream is already present on the layout, it will blink with a greenish yellow frame

Channel/map popup must be enabled for the target application window in the advanced window settings. You can
reach them by clicking the multidisplay setup button in the upper right corner.

3
L

Advanced window settings

== Add window Identify displays
Search
™ Layou
Maonitor 1 Default
T Chami
ot Local
» Il
=
Cite Window name S ut or sequence
Default
Q@ Maps

e
[[llf Startup display
ol

Nick!

[ Start full screen

B} Butto
o Allow channel/map pop-ups & Allow layout pop-ups

Allow single item and layout popup in the window properties
Markers for the mobile app channels have another interactive feature. They move along the map when the mobile
app is streaming video to the server (GPS data must be enabled in the app and in the map settings). When the

streaming stops, such markers will return to their default position. These can be clicked for popup, just as regular
channels.

Layout Popup

To pop up a layout consisting of several items (channels and/or maps):

e with your right mouse button, draw a rectangle over the channels you want to see: click > hold to draw >
release when ready

¢ alayout containing all selected channels and maps will be formed automatically

¢ the layout will pop up on the first workstation display that has layout popup enabled

Make sure to enable layout popup in the window settings for this feature to work. If none of the displays have layout
popup enabled in the window properties, nothing will happen.
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Draw a region with the right mouse click, then release to popup

Other Interactive Markers

Depending on the server configuration, maps can also contain other types of interactive contents.

User button markers placed on a map can be double-clicked to trigger the associated action. The marker will blink
indicating that the action is being executed. This action is similar to clicking a user button in the resource panel.

Links to other maps will lead you to the target map within the same viewport. If included into the selection for
layout popup, as described above, map markers will add the target maps to the layout contents.

Links to shared layouts can be either double-clicked or selected with the right-click selection (one at a time).
Selecting multiple layouts similarly to channels will do nothing; selecting a layout link together with channel
markers will give priority to channels (layouts will be ignored).

Each door marker will reflect the current door status according to the settings defined in the map
configuration. Also, every door marker can be left-clicked to bring up a drop-down menu with associated door
actions, these being: lock the door, unlock the door and temporarily unlock the door.

Other Non-Interactive Markers

Some of the map overlays are purely informative.

Indicators reflect the current state of the server-side indicator objects. Their value may change based on server
events, such as I/O, detector status changes etc.

You can also attach Indicators to the Polygon markings inside the Luxriot EVO console, which will change marking
color according to the Indicator state.
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21 Crosslinks and Other Interactive Contents

Luxriot EVO servers provide several types of interactive resources called CrossLink: these can be webpages or
remote workstations. You can drag and drop them onto viewports as regular channels, enable the remote control
and then manipulate the contents. Crosslink devices and workstations can be recorded (so they may have some
footage in playback modes), while direct Crosslinks go straight from the source to the Luxriot EVO Monitor
application and allow multiple concurrent sessions.

The main differences between Crosslinks and Crosslink devices:

e Crosslinks go directly to Luxriot EVO Monitor, while devices go through Luxriot EVO servers
e 5o Crosslinks are simple Web contents, and Crosslink devices are like interactive video streams
e Crosslinks are therefore not recorded and do not have any archive, unlike interactive devices

e also, Crosslinks can be used simultaneously by many users (independent sessions), and if you close the
viewport with the Crosslink, next time the base URL will be reopened

¢ on the contrary, Crosslink devices have user priorities for remote control

e channels produced from Crosslink devices do not have audio but do have two video streams (main/sub),
just like regular video channels

As for remote workstations, these are also server-side devices, and you can think of them as recorded remote
desktop sessions.

Below, you fill find details on how to find and use each type in Luxriot EVO Monitor.

Direct Crosslinks

These are fully interactive Crosslinks available for browsing, with live view only. You will find them in the Resources
panel on the left, under the dedicated Crosslinks section. Crosslinks are not recorded, thus, the streams go directly
from the source to the Luxriot EVO Monitor application(s).

To start, open the Resources section on the left and then drag and drop the desired Crosslink onto the viewport. You
may want to use a single viewport layout template for better browsing experience. Crosslinks may be grouped: drag
and drop the entire folder to the viewing area to put all pages onto the layout.

An interactive Crosslink example

After the Crosslink is displayed, you can go ahead and control the page contents simply by clicking the contents
as if the viewport was your Web browser. You can click links, type texts, log into your account etc.
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Due to security reasons the following restrictions apply:

e it is impossible to navigate away to another website (domain)*

e copy-paste is not allowed

¢ no file upload

e pop-up windows or new tabs may be restricted in Luxriot EVO console

¢ Some pop-up functions may not work properly. If possible, try to open them directly in the web browser
e 1o right-click menus

Dedicated Crosslink tabs
With the version 1.26 release, your administrator can configure the Crosslinks to appear in a separate tab inside the

main menu. In such case, the particular Crosslink will disappear from the viewports and become accessible via the
Main menu tab, the same name as the title for your Crosslink set inside the console app.

If your system administrator enabled file downloads from the Crosslinks, you find those downloads inside the
library after the download is complete.

=
L_Ej Llive [> Playback I5FSequence [@]SmartSearch /) Alerts Library EEH Video Wall Data Sources  [ol, Reports (_3 LPR ‘“‘ Fi [ MyWebpage
e |
WAKIPEDIA
The Free Eneyelopedia

Example of the dedicated Crosslink tab inside the Main menu (the tab marked with the red rectangle)

*Navigation to lower level domains is allowed. This means, for example, you can switch between sub-sections of the
website like lv.wikipedia.org and it.wikipedia.org, but you cannot navigate away to wiktionary.org. If there is a
redirect attempt (e.g., you click on a banner) or you try to navigate away from the specified domain (if the link leads
to a different website), a corresponding warning will appear in the Alerts section of Luxriot EVO Monitor.

/. If you click some button or link on the website and nothing happens, there's a big chance the target page
belongs to another website (domain). Check the Alerts section for warnings.

Use the overlay controls in the bottom right corner to go back and forward in the browsing history, and to refresh
the Crosslink.

{ > °

There are no statuses in the bottom left corner of the viewport, as this is not a video stream: the Crosslink is
rendered on the Luxriot EVO Monitor side.

Sound is automatic and it will start playing if the remote page plays some content with audio. On the right side, the
is a serollbar, just like in your browser.

/. Please note that this feature is not a fully-featured browser but rather a facility that enables cross-platform
interaction. Certain restrictions apply. Media-rich webpages may be slower than normal. For feature-rich
browsing, please use regular Web browsers.

Crosslink Devices

It is also possible to set up a Crosslink on the Luxriot EVO server side so that it is recorded, too. In this case, it is
treated like a regular video source: you will find these interactive Crosslink channels under the Channels section
of the Resources panel.

' Ask your system administrator to configure visual groups so that the interactive channels are separated
from video channels. It is possible to create the nested Crosslink groups inside the resource pane based on
visual groups, and add a unique icons for each resource inside the Luxriot EVO console.
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Drag and drop any Crosslink from the list to put in onto the viewport.
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Interactive weather map in Luxriot EVO Monitor

Viewport overlay controls are very similar to those of regular video channels:
e top left corner: X to remove the channel, lock to pin it to the viewport, channel name and (optional)
attached user buttons
e top right: timestamp or error text
e bottom left: stream properties and recording status
e bottom right: the usual channel controls + remote control ON/OFF

Remote Control
Enable to send mouse and keyboard commands to the remote host

The remote control toggle is displayed by default and turned OFF. To initiate remote control, click the icon with
the "clicking cursor" so that it becomes yellow. You can now interact with the channel contents.

) If, during the remote control session, another user with a higher priority takes over, the control will be
transferred to them. You will be able to resume your session after they stop interacting. A corresponding
message will appear in the channel's notification panel.

You can create snapshots and bookmarks, toggle streams, or switch to instant playback and regular playback as
usual, just like with any video stream.

Use the channel's notification panel to check if there were any errors or warnings (including those about redirects).

) The displayed image quality greatly depends on the resolution, compression and bitrate. If you experience any
issues (e.g., the text is unreadable):

e try switching the streams (main/substream)
e ask your administrator to change the channel settings in Luxriot EVO Console

Remote Workstations
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Similarly to Crosslink devices, there can also be devices that provide contents from a whole remote machine. You
can think of them as of Teamviewer or RDP sessions. While Crosslinks only display a single page, with the remote
desktop access you can use any applications on the remote machine.

In Luxriot EVO Monitor, you will find these entities in the Channels section of the Resources panel on the left. These
do not have any special icon so we recommend that your system administrator configures visual groups for your
convenience.

- - )
oy o ol J = Connection (2 servers)  File  Edit View  Tools

«

ja) < M Observing » emptiness o

™ Layouts ¥ | X @ XLink Advanced - Office PC
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Live remote session from Luxriot EVO Monitor using the CrossLink technology

Viewport overlay controls are very similar to those of regular video channels:
e top left corner: X to remove the channel, lock to pin it to the viewport, channel name and (optional)
attached user buttons
e top right: timestamp or error text
e bottom left: stream properties and recording status
e bottom right: the usual channel controls + remote control ON/OFF

Remote Control
Enable to send mouse and keyboard commands to the remote host

The remote control toggle is displayed by default and turned OFF. To initiate remote control, click the icon with
the "clicking cursor" so that it becomes yellow. You can now interact with the channel contents.

' If, during the remote control session, another user with a higher priority takes over, the control will be
transferred to them. You will be able to resume your session after they stop interacting. A corresponding
message will appear in the channel's notification panel.

Keep in mind that during remote control:
¢ you will be unable to copy and paste text of files from the local computer (remote machine clipboard will
work)

¢ system key combinations will not be sent to the remote PC (use on-screen keyboard or your mouse for
this)
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For example, it you press Alt+TAB during the remote session, your local computer will catch that combination.

You can create snapshots and bookmarks, toggle streams, or switch to instant playback and regular playback as
usual, just like with any video stream.

/. Important note: this connection use dynamic frame rate. This means, the stream frame rate will be close to
1FPS while there is nothing happening. If the remote user does something visual, the FPS will grow.

Non-Interactive Crosslinks

Some of the channels may also be non-interactive. For these, the remote control toggle button will not be displayed.

These are regular video streams rendered from an HTML source, and there is no option to change their contents
from Luxriot EVO Monitor. If you only see this kind of Crosslinks, the case may be that there are not enough
CrossLink licenses on the connected server and the channels were configured to use a regular channel license.
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22 User Buttons

User buttons, as well as other types of resources from the connected servers, are available in the Resources panel on
the left. Note that this resource is not available for the free server license.

User buttons in Luxriot EVO Monitor

User buttons are created via Luxriot EVO Console; button behavior is defined via Luxriot EVO Console using the
Event & Action Configurator. There are three ways of using user buttons in Luxriot EVO Monitor:
¢ double-click any button in the list of resources to make it trigger the action assigned to it

¢ drag and drop any user button to a live view viewport to make the user button appear as an overlay
control for your desired camera, then click it once at any time to trigger the relevant action

¢ double-click user button markers on the maps (markers are configured via Luxriot EVO Console)

User buttons cannot be added to the viewports that contain maps. Instead, go to the map management section in
Luxriot EVO Console and add user button markers to the desired maps to use them in Luxriot EVO Monitor.

If the User Button was added as a Channel Member via Console, you will see it in the corresponding Viewport in the
Live view, Instant playback, and Bookmarks - channel preview.

The example of the custom button inside the Viewport, and the Bookmark alarm

=

s User buttons will be visible inside the Live View and Instant Playback Viewports of corresponding Channels.
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Each time a user button is pressed, the corresponding log entry appears in the Alerts section of Luxriot EVO

Monitor.
= Connection (1 servers) File Edit View Help

I Sequence explorer £\ Alerts Library

User button "Close Stargate” successfully activated on server Local Server (admin@locathost:60554) 2/4/2016 1:40:44 PM

User button "Close Stargate” successfully activated on server Local Server (admin@locathost:60554) 2/4/2016 1:40:06 PM

Alerts on user button pressing
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23 Video Wall

Video wall configuration in Luxriot EVO is very flexible and it allows you to set up video output in virtually any
physical display combination. Templates for video walls are set up via Luxriot EVO Console and then they become
available in Luxriot EVO Monitor, depending on the permissions of the connected user. Using the dedicated Video
Wall tab, you can easily control the contents of all available video walls.

Note that this functionality is only supported for the Luxriot EVO Global software edition. Connection to a Luxriot
EVO Global server is required for the video wall functionality to become available. If some of your video walls are
hosted on Luxriot EVO Recording Server machines, you still need to connect to the Luxriot EVO Global server from
Luxriot EVO Monitor: if the connection to the central management servers is lost, your client application will
automatically re-connect via mirror (if available) or to the recording server(s) directly. There is no need to enter any
of the Luxriot EVO Recording Server addresses manually.

Video Wall Setup

The idea of the video walls in Luxriot EVO is that you create a layout in Luxriot EVO Console and then assign
Luxriot EVO Monitor application windows to video wall screens in the layout. Afterwards, the whole video wall can
be easily managed from any location.

In this section, we will review the settings for the Luxriot EVO Monitor application windows and see, which ones are
required for the video wall setup.

Advanced Window Settings

To access window setup in Luxriot EVO Monitor, open the Live section, click the Multidisplay setup g8l button in
the upper-right-hand corner - just under the main menu - and then click the Advanced button to bring up the
configuration dialog box.

Advanced window settings

Identify displays

Monitor

Window 2

Advanced window settings
The advanced window settings dialog box offers the following possibilities:

e create windows for the available local displays and manage their properties

e assign default layouts and sequences to windows (local displays only)

¢ bind windows to video wall displays
In the upper part of the configuration dialog box you will see the available window list. Already there by default is
the main Luxriot EVO Monitor window (marked as Primary), which cannot be deleted or renamed. More windows
can be added, their number being limited to the number of displays physically connected to the workstation. For
each window, the following items are displayed in the summary list:

e display number

e primary or not

e startup layout, if set

e channel/map pop-ups allowed or not

¢ layout pop-ups allowed or not

e start fullscreen or not

e video wall screen number, if set
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To add a new window, click the + Add window button in the upper-left-hand corner (when the window amount has
reached connected display amount, the buttons becomes grayed out). You can also create additional local windows
by clicking the display thumbnails in the Multidisplay setup menu (before opening Advanced settings).

Window name Startup layout or sequence

Window 2

Startup display Sl
» Start full screen

[ Allow channel and map pop-ups «/ Allow layout pop-ups

Window settings
Select the parameters of the new window and click Save for the changes to take effect.

All these parameters can be set for each window (including default primary window) in the dialog box section below
the window list. The following settings are available:

General settings:

¢ Window name: set window title to be displayed in the application title bar of each window
e Startup display: select a display to start the target window on (click to highlight with a yellow frame)

¢ Startup layout or sequence: pick an item to be displayed on window startup; select (Default) to auto
fill a 2x2 layout at Luxriot EVO Monitor startup

e Start full screen: enable the target window to start in full screen mode; if this is disabled, the window
will start up simply maximized

e Allow channel and map pop-ups*: enable video/map popup on the target window as a result of
event/action rule execution

¢ Allow layout pop-ups*: enable layout pop-ups on the target window as a result of event/action rule
execution
Video wall section:
¢ Video wall screen: select to make the target window a part of the video wall configuration; choose the
video wall from the drop-down list below

e Video wall visual element: choose (click to highlight with a yellow frame) a video wall screen to serve as
the target window output

o Tiled display: enable to split the target video wall screen into several physical displays
o Tiles: select the grid size and click a tile to assign the current window to it

*Pop-up options can be selected one at a time: enabling object pop-ups disables layout pop-ups and vice versa.
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» Video wall screen + Tiled display

Available video walls: Choose tiled layout and click a tile to assign current window to it:

erver * Matnx Video Wall Rows: 3

Video wall screen assignment

In order to delete a window, select it in the list and click the recycle bin m icon in the upper-right-hand corner; you
will be prompted to confirm the action. Note that all the window settings will also be removed; once you have
removed a window and clicked Save in the Advanced settings dialog box, the deleted window will also be closed.
You can remove any window, apart from the primary one.

Advanced settings

Are yon mae you maed 1n peEranedly remove windnw kiam
scrRan’T

Confirm deletion
Assign Video Wall Screens

Briefly: for each application window, enable the Video wall screen setting in the lower section > select the video
wall from the drop-down list > click the desired video wall screen > save. Window settings are explained in more
details above.

For the video wall to be available here, the video wall template should be pre-defined via Luxriot EVO Console, and
the current user account must have the Manage video wall permission granted. If you have enabled the video wall
setting but there are none in the drop-down list, make sure you have your Luxriot EVO Global server connected and
check its configuration in Luxriot EVO Console.

If you wish to combine several physical displays into one virtual video wall screen (tiling), enable the Tiled display
option on the right, then choose which screen side each display belongs to. Tiled walls are explained fully below.

Tiled Displays

Sometimes, flat panel displays with no bezel are combined physically into one ultra high-resolution surface. Luxriot
EVO Monitor supports such configurations and allows splitting each video wall display into several tiles, and further
assigning of individual tiles to different physical displays. These displays can be driven either by the same or
different workstations: the resulting tiled wall will look the same. Thus, a set (group) of physical monitors (tiles)
form a single video wall screen, which is then used as the contents' destination. The tiles are set up once, and this
configuration layer is then completely transparent for the video wall management: you will simply address video
wall screens later on, no matter if each screen consists of one or more windows.

To enable tiling, first assign all displays to the same video wall screen, then choose different regions (tiles) for each
physical display using the visual elements.
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 Video crae ¥ Tiled display

Choose tiled layout and click a tile to assign current window to it:

Tiling example with channel output visualization

Example: stretch one channel output to two Luxriot EVO Monitor application windows, which run on two different
client machines.

Configuration:

o for both windows:
¢ enable video wall in the advanced window settings, as shown above
e choose the same video wall and the same video wall screen (e.g., video wall Matrix, screen 1)
e enable the Tiled display option
e enter 1x2 layout
e for Window 1:
e choose tile 1 (left)
o for Window 2:
e choose tile 2 (right)

As a result, Luxriot EVO Monitor will automatically treat two displays as a single screen, and any contents sent to
this video wall screen will be stretched to fill both physical surfaces.

Note that the contents of the tiled displays can be defined via video walls only, either by sending items to the
video wall screens from the item menu (...), or by opening the video wall management tab. If you send items to local
screens (by double-clicking or dragging and dropping them from the resources' list), only a part of the tile will be
used, producing an undesirable effect.

=

/ Make sure to calibrate your tiled displays so that they have similar brightness and co lour settings. These
settings are usually available via operating system or utilities bundled with the graphics card drivers.

=

./ Many different displays can be subscribed to one and the same video wall screen.

Example:
e in the office, video wall Screen 1 consists of one physical display, and in the control room the same
output is sent to four displays using tiling

e when someone manages the video wall from the corresponding tab, the Screen 1 contents is changed
simultaneously in both places

/. Both channels and maps can be tiled. However, visual overlay elements (e.g., buttons, portals) will be

unavailable. Text from data sources will overlay the video, as usual.
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Video Wall Management

Once the Luxriot EVO Monitor application windows have been attached to the video wall displays, it becomes
possible to send resources directly to any video wall display. You can do this in two ways: send resources directly
from their menu, or enter the full-featured video wall management mode. The first option is convenient for quick
edits, while the second one allows full control over the video wall contents. Both modes handle video wall screens
and not individual tiles, if the tiled displays are enabled. Thus, you do not need to worry about the tiles: Luxriot EVO
Monitor will take care about them automatically.

Below, you will find guidelines on how to administer video wall contents in Luxriot EVO Monitor.
Quick Content Output

To send any resource directly to a video wall screen, click the Expand [l button near resource name in the list on
the left and choose Display on -> Video Wall -> pick video wall -> pick display number/name. Available resources
are: layouts, layout sequences, maps and individual channels.

To send the currently displayed screen contents to the video wall display, do the same thing from the layout
menu in the upper-right-hand corner (above live view).

P Videowall

Advanced Management

Switch to the Video Wall tab on the upper panel to access advanced video all management. In this mode, your
Luxriot EVO Monitor acts as a controlling client for all the video wall members.

Here, in the left-hand panel, all available resources - both local and server-side - are listed. These are:
¢ video walls: fetched from Luxriot EVO Global servers, each video wall can be expanded to view its
displays
¢ layouts, layout templates and layout sequences: both local and shared via Luxriot EVO Global servers;
new sequences can be created from here by clicking the Expand |2 button
¢ channels: individual channels from all connected servers
¢ maps: fetched from connected Luxriot EVO Global servers

tion (1 servers)  File  Edit  View
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First, drag and drop your desired video wall from the resource list to the upper section of the window. You can
drag and drop either the video wall name itself or any of its displays. Video wall display arrangement will appear in
the upper part of the window with its corresponding display numbers and names.

Click any cell to view the current contents of the target display: it will be shown below the video wall arrangement.
The title bar of the lower window part will reflect the video wall display number and name, currently displayed
resource type (layout or layout sequence); in the right-hand side of the panel you will have the layout menu, which
will allow you to quickly set the currently shown layout as startup layout for the target video wall display. If the
current video wall display has a layout sequence on it, this menu will offer options to set the current layout
sequence as startup and also to stop the sequence. "Startup" in this context means the start of the Luxriot EVO
server running the target video wall.

-

/. To see selected cell content - toggle the Live video ON. Also you can disable Live view preview by toggling the
same switch OFF.

"
-
-

/. You can set startup layouts and sequences only when Luxriot EVO Monitor is connected to the Luxriot EVO
Global server.

This means, under the following circumstances you will be unable to set startup contents:

e when the video wall is kept on the Luxriot EVO Global server but connection to it is lost (mirror
connection still active),

e if your video wall is assigned to one of the Luxriot EVO Recording Server machines, but connection
to the Luxriot EVO Global server is lost

You can still manipulate the video wall contents manually in both these cases.

Set current layout as startup

In the lower part of the window, you can manipulate the contents of the target video wall display in the exact same
way as you would do in the usual live view mode. You can:

e drag and drop layout templates, layouts and layout sequences from the Layouts section of the Resources
panel on the left

e create new layout sequences from the Layouts section

e drag and drop individual channels from the Channels section

e drag and drop maps from the Maps section

¢ close channels and maps in the layout by using the X button in the upper-left-hand corner of the viewport

¢ swap channels and maps within the layout by dragging them by their titles

e lock channels and maps in their viewports by using the lock overlay control in the upper-left-hand corner

¢ digitally zoom channels by using the digital zoom overlay control

e digitally zoom maps by using your mouse wheel

Indication conventions:
e currently selected video wall screen is marked blue green

e the information icon m next to the layout/channel title shows the name of the user who has placed the
corresponding layout/channel: hover your mouse cursor to see the user name

¢ the information icon is highlighted yellow for five seconds after the corresponding resource has been
placed

All changes to the video wall display contents are immediately applied and all other users who are managing the
same display at this moment are notified by the highlighted information icon. If selected arrangements are not saved
as startup layouts, they will be kept until remote Luxriot EVO Monitor applications are restarted.

" When your Luxriot EVO Monitor is connected to the mirroring server instead of Luxriot EVO Global (server
color indicator changes from green to yellowish), all the changes you make to the video wall configuration are
kept on the mirror server. When the Luxriot EVO Global machine comes back, all changes are synchronized
back to the primary central management server. All this happens automatically and transparently for the
Luxriot EVO Monitor users.
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24 Playback (Archive) Mode

Select Playback tab to switch to archive playback mode. Your current layout will be used and recorded video streams
will be displayed for channels with enabled recording. If you wish to load footage from a different channel or
channels, or use a different layout or layout template, use the Resources panel on the left:

e Layouts: double-click your desired layout to load it
¢ Layout templates: double-click your desired layout template to load it, then double-click or drag and
drop the channels of your choice to fill the viewports
¢ Channels and webpages:
¢ double-click a channel to load it automatically within the current layout (first, empty viewports
are filled, then non-locked channels are replaced one by one)
e drag and drop a channel onto any viewport to load it there

By default, the layout is synchronized with the live view as you switch between Live and Playback tabs. However,
you can disable this synchronization by allowing different layouts for live and playback in the Application settings,
under Usability (scroll to the bottom to see this setting). For multichannel layouts, all channels will be played
synchronously.

L Live = [> Playback 0¥ Sequenceexplorer ¢ 3 LPR /7 Alerts  [5] Library = Connection (1servers)  Fle  Edit  View  Help
14

Flayback

i Layouts

™ 5 Screen (1x1)

3C Channels

war #1
3 Allay North
20 Alley South

32 Conference Hall

22 Reception
“Alley South

1 Channels

M 20 m w55 o] ’- Ip 55 v1m o1 2an B ——@
Archive Playback mode

All channels are listed under the servers from which they originate; or, if you have chosen to merge resources in
the connection properties, they will form an alphabetically sorted list. Each channel can be clicked and expanded in
order to access recordings of its main an/or secondary stream, as well as separate tracks recorded on failover
servers. Use the search field on top to quickly find the desired channel.

) All the footage having no associated active channels will be available under Orphan archive tracks. Such
recordings include footage from removed channels, renamed channels and also Luxriot VMS archive.

Also, if your current user account does not have permissions for certain channels but has access to a server's
recordings, all channels will be also listed as orphans.

) Luxriot EVO archive is protected with watermark. If archive contents has been modified with third-party
tools, a warning will be displayed during playback and a critical level entry will appear in the Alerts section.

Timeline

The timeline in nlavhack ic an antline of the archive recardinoe and it ic dienlaved helow the viden Denendine an
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your application preferences, it may look different, but the logic remains the same. Use the timeline and controls
on/next to it to browse through recordings.

The description below will let you better understand how the timeline works and improve your archive browsing
experience by revealing some tips.

15§10:59:16 AM

FGrundig GC-G1536F on 1921663714

3 Channels

Multichannel playback timeline
Stripes on the timeline represent different recorded data streams. Legend:

o the yellow vertical line denotes current playback position

¢ time intervals show the timeline scale; click and drag left/right to move the timeline

¢ hover your mouse over the timeline to see a thumbnail (stream/bookmark preview)

e use your mouse wheel to zoom the timeline in and out (current playback position will be used as centre)
¢ the narrow white horizontal line shows recorded video

¢ the cyan line (a little bit wider than the white one) indicates motion

o the blue line (a little bit wider than the cyan one) shows recorded incoming audio

o the wide semi-transparent white line denotes VCA metadata*

e the wide (EKIBEGEH one in the background is external textual data

¢ bookmarks look like little flags of different @8l (colors for various severity levels can be customized via
Luxriot EVO Console)

Instant playback timeline containing video, external data overlay, and one bookmark

The visualization of data tracks (layers) is non-continuous, with the timeline overlay of the target color only
present during periods containing the corresponding data.

' *Earlier Luxriot EVO versions had a continuous timeline stripe for VA metadata. Starting from v.1.20.0,
metadata are displayed similarly to motion, with the timeline overlay only present during periods with
analytics detections.

The video footage outline is shown twice by default: the upper timeline displays the contents of the currently
selected stream, with the corresponding channel name shown on the left; the lower timeline shows a content
summary for all the channels currently present in the viewport layout, both timelines being synchronized. The
second timeline with summary can be optionally disabled via Application Settings. You can also choose to have a
separate timeline for each channel.

Timeline selection for export and protection can be created as follows:

1. Click the timeline once to put the playback marker onto the desired starting position

2. Click the selection marker icon [

will appear on the timeline
3. Place the playback marker to the end of the desired interval
4. Click the selection marker again to create the selection
5. Click the selection marker again to discard the selection

below the timeline to mark the beginning: the corresponding mark

Once the target interval has been highlighted on the timeline, you can browse the timeline as usual; the selection will
only be discarded if you click the selection marker icon once again or switch to other tabs (live etc.).

The created selection can be used for archive related actions where it is necessary to choose an interval (e.g., export
video clip, delete or protect a part of the archive).

! The timeline appearance is indicative and not 100% accurate, i.e., gaps in the archive may not be visible at
certain zoom levels. For example, one minute long gaps will not be visible on the two-week scale. To see more
details, zoom in using your mouse wheel or using timeline controls.
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Overlays and Playback Controls

The following viewport overlay controls are available in the playback mode:

e Upper left:
e X - close the stream and free the viewport

o viewport lock status: unlocked (default) or locked; unlocked means that the video in this
viewport can be replaced by other camera if you double-click or drag it from the Resources

e camera name
e Bottom left: stream details

¢ motion detector status: running = motion present, standing still = no motion detected

¢ video codec of the stream

e picture resolution, abbreviated

e stream frame rate, FPS (only displayed up to 4x playback speed)
e Bottom right: controls

¢ audio ON/OFF: disables or enables audio playback

e DPTZ controls ON/OFF

e aspect ratio (auto/stretch to fill viewport/original)

e motion grid ON/OFF

» L -2 domam aos | Prp s amamm2np] ORN @ EDO @MY <

SR

Playback controls
The playback mode controls are located at the bottom of the window:

o far right and far left of the timeline:
e timeline start and stop timestamps
e use the <> arrows and drag left to zoom out/drag right to zoom in the timeline
¢ yellow arrow indicates the location of the nearest footage if it is not present on the timeline at
the time (this can happen, e.g., after zooming the timeline)
e playback controls:
¢ use the Play/Pause button to start playback
¢ click and drag along the timeline to move the current cursor position
e use the <| & |> arrows near the Play button to go one frame back/forward
e -/+ steps: click to go back/forward with a step of 10 seconds, 1 minute, 10 minutes, 1 hour or 1
day
e |< >| arrows: go to the very beginning/very end of the footage
e playback speed:
¢ during playback, drag the blob to adjust playback speed from +/-0.5x to +/-128x (you can use
mouse wheel for this, too)
e the Pause button duplicates the main pause control
e when paused, set playback speed to start playing video (without pressing the Play button)
¢ additional controls on the left and on the right of playback controls:
e go to the next/previous motion event
e I and IT markers can be used for selection (for export or to protect/remove footage)
¢ clock button: go to a specific date and/or time
e bookmark: add bookmark
e camera button: take a snapshot of the currently selected channel
e camera with a layout: take a multichannel snapshot
¢ video button: export a piece of video

The behavior of the controls can be adjusted via application settings. This includes timeline presentation, stream
selection for playback, as well as preferences for video and snapshot export.
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' Inthe application settings, under Usability, you can define how your mouse wheel controls the playback
speed:

e contiguous: wheeling in different direction increases or decreases the speed to the next value
e pause: decreasing the speed will drop it to zero, pausing the playback

Calendar

Click the Archive Calendar button in the top right corner to toggle an additional panel containing archive calendar

view. This control allows you to see for which dates and time intervals the footage is available, and to switch to some

particular period quickly.

CJtive [> Playback 35F Sequence [@] Smartsearch /0 Mlerts [i] Library oo Reports €23 LPR = Connection (1 servers)  Fle &t View Help
M sackmarks =4 vea Archive Calendar

Month

10-05-2017 Thu 13:08:24

March
July

Octaber November

October 2017

12:0-1:00
400-5:00

8:00-9:00 9:00-10:0 10:0-11:0

12:0-1:00 1:00-2:00 2:00-3:00
:00 5:00-7:00 7:00-8:00

8:00-9:00 9:00-10:0 10:0-11:0 11:0-120

10/5/2017 | 8:00:00 AM

24041 t0mn 1 105 ] P +105 100 41080 414 1204

Playback mode with calendar enabled
Units of time (months, days and hour intervals) marked with a blue underline contain footage for at least one
channel currently displayed.

Relative Search

You can search by the relative time interval in Playback -> Bookmarks, VCA Search, External service search. The
search will return relative interval from now on and back as much hours or days as you will provide as a number of
units.
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Time interval selection

(O Date and time interval

Last Day(s)

Cancel

Relative search window example
Bookmarks and VCA Event Search

The Bookmarks button in the top right corner opens up an additional panel that allows you to browse the existing
bookmarks. You will find more information on this in the Bookmarks section of this document.

Similarly, the VCA button next to the Bookmarks button in the top right corner provides video analytics event
search functionality (recorded video analytics events from server): please refer to the VCA Events section of this
manual for further details.

Archive Protection and Deletion

It is possible to mark a certain part of the archive and use the selection for further deletion, or protect a part of the
archive from being removed. Special user permissions are required to allow this functionality.

If you choose to protect a specific part of the archive, it will be impossible to erase it from the Luxriot EVO
Monitor application, and that part of the archive will also be ignored by server when applying quotas. To disable
protection, you need to log into the server via Luxriot EVO Console and change the archive protection settings.

If you choose to remove a part of the archive, it will be erased permanently with all related auxiliary information
(audio, motion metadata etc.). Protected intervals cannot be removed; when such an action is attempted, you will
get a warning in the Alerts section.

/. When you delete a part of the archive, it is erased immediately. This action cannot be undone. Please
mind applying all the necessary security precautions (e.g., take care of a good administrative account password
and review user permissions) to avoid undesired data loss.

/* When you protect a short period of the archive (e.g., several minutes), in fact, the whole file containing
this period is protected from erasing. Therefore, intervals adjacent to protected period will also be locked. You
can verify the exact protected interval by opening Luxriot EVO Console >> Monitoring section >> Archive
statistics >> Protected intervals.

General steps for both these actions are:

[
1. Mark the beginning and the end of the target interval on the timeline using the markers [

timeline

below the
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2. Use the buttons in the bottom right corner to either remove ﬁ a part of the archive or protect gl i
from deletion

You can skip the first step and press the delete/protect buttons without any selection on the timeline; then, the last
five minutes of the recordings will be used as the target interval.

7/13/2019J15:53:35

Store

1 CHANNELS

h J |4 248 -1 -10m -1m -105 {|>|} asamamaH2mp - O M A A D @O
—

Selection on the timeline

All footage that has been protected from erasing can be un-protected via Luxriot EVO Console, by logging with an
administrative user account with corresponding privileges. Until then, the protected part of the archive cannot be
erased by user actions (as described above) or by automatic erasing based on quotas.

/. Protected archive is excluded from recording quotas and will not be overwritten. Also, such footage is

protected from manual deletion. Therefore, when protecting a large part of the footage, make sure that the
target storage has sufficient free space, and set lower storage quotas, if necessary.
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25 Sequence

The sequence explorer is an archive playback extension with additional tools for footage analysis. The whole
recorded stream can be split into smaller pieces down to 2 minutes in length; each of these can be played separately
or exported with a single click.

In the Luxriot EVO Monitor upper panel, click the Sequence tab: the current main window will then display the
sequence explorer with empty viewports.

[ Playback =I5 Sequenceexplorer /%y Alerts  [E] Library Connection (L servers)  Fle  Edt  View

Flease add a channe| ff# Calendar

04:28; 30 PM

Parking

HHEHHEHXEXHHSR

FOA15 on 192.168...,

Sequence explorer interface
Interface Overview

Interface elements have the following designations:

e Calendar: specify the time period to be analyzed by entering date/time boundaries, and also set the
viewport layout
e date can be entered manually or selected from calendar view
e time can be entered manually or adjusted by mouse wheel (select the value to be changed and
use mouse wheel to increase/decrease it, while keeping the mouse cursor over the field)
e minimum time period is 120 seconds
e available viewport layouts are: 3x4 (default), 3x5, 4x3, 4x6, 6x4, 5X5 screens
¢ Top panel: <> arrows enable users to browse viewing history within the channel in use; the name of the
channel being used is displayed
e Main window: displays video clip sequence with corresponding controls; empty viewports mean that no
footage is available for the time period selected
e Bottom panel: contains global sequence controls for the whole currently displayed period (and not the
selected sequence elements)
e the << and >> arrows on the sides enable users to load the previous/next portion of the footage
sequence, with time period equal to the one set in the Calendar
e next to the arrows, the date/time boundaries of the current video portion are shown
e Play button in the centre of the panel will open current video portion in the Playback mode
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e Video button in the centre of the panel brings up the Video export dialog box
Make Sequence

Drag and drop the desired channel from resources onto the main window; the camera name will appear at the top.
Note that the sequencing works with one channel at a time, so if you drag and drop another channel onto the
explorer window, all previous changes will be discarded.

Select sequence timing in the calendar panel on the right and then click the Make sequence button. Video footage
from selected time range will be divided between all viewports, so that all of them will contain video clips of equal
duration. For instance, if the selected time range is 2 hours and a 3x4 layout is set, each viewport will contain a 10-
minute video clip: (2¥60)/3*4 = 120/12 = 10 minutes.

[> Playback =I5 Sequence explorer /T Alerts [ Library = Connection (L servers)  Fle  Edt

< X Loeal server > Parking # Calendar

A& 41300 PM

4:13:00 PM

05:07 : 40 PM

Make sequence

FER154 on 192:168...
™ 44226 PM

Built sequence
From this point onwards, you have several options for creating a new sequence:

e enter a new time period on the Calendar panel and click the Make sequence button

e select one or multiple sequence elements and click the Make sequence overlay control (see the control
descriptions below)

e double-click a single sequence element to split it into a new sequence

If you choose to build a new sequence out of one or multiple sequence elements, their date/time boundaries will be
set as new boundaries, and the video clip in the resulting sequence will be of shorter duration. In this way, any
footage can be split into smaller and smaller chunks down to two minutes, facilitating footage analysis process and
making it easy to find the scene of interest within a larger fragment of footage.

Use the << and >> arrows on the bottom panel to go back and forth along channel timeline. The size of the jumps
back and forth will be equal to the base time period set in the Calendar.

Sequence Controls

Viewport overlay controls are available for each sequence element. Click any piece once to select it; click one screen
once and then click another screen to select a series of fragments. Selection border style will help you control your
actions: a dashed line denotes a single click, solid line appears after the second click. As a result, you will always
know, which selection stage you are on when selecting multiple screens.
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5:03:06 PM

o

Once you have selected one or a set of fragments, overlay controls in the bottom right corner of the selection offer
the following possible actions:

e Magnifier button: make a new sequence out of selected fragments; use the History controls <> in the
upper panel to go back

e Play button: play selected footage in archive playback mode

¢ Video button: export video from selected time range (no additional Set time range window is displayed)

Multiple regions are selected with two clicks

Timestamps in the top-left and in the top-right-hand corners of each viewport represent time range of the contained
footage fragment. In case multiple screens are selected, the intermediate timestamps are skipped and time frames
for the multi-fragment footage portion are displayed.

Playback

Click the Play button on the bottom panel to open the whole inspected footage portion in the archive playback
mode. The equivalent button on each of the selected sequence fragments will open just that specific fragment for
playback. Playback operation is exactly the same as for usual archive viewing and it is explained at length in

the Archive Playback topic.

Video Export

Click the Video button in the bottom panel to bring up the Video Export dialog box and set your desired time range
for exported footage; channel selection is limited to the one channel open at the time in the sequence explorer.

©2024 A&H Software House. All Rights Reserved.

08



Luxriot EVO Monitor User Guide

Video Export

Video stream

Parking

Start from date Stop at date

12/22/2015 i 12/22/2015 ::

Start from time Stop at time

04:13:00 PM 05:07:40 PM

Cancel

Adjust the date/time boundaries during which you want the footage to be exported

The Video button overlay control in the fragmented sequence screens will automatically export video from selected
time range without additional prompts. In either case, the exported video will appear in the Library.

o
[&) Library
Library notification

Sequence explorer works with the streams based on the time intervals. If you want a more intelligent archive
analysis tool, go to Smart Search to base your search on motion in certain regions.
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26 Smart Search

Along with regular archive playback and sequence exploring, Luxriot EVO Monitor application provides the smart
search feature, which allows you to specify a region of interest and let software search for motion events in the
defined area based on the existing motion detection (MD) metadata. This advanced search option is available for all
Luxriot EVO servers and editions.

' There are two types of motion analysis operation: grid and area (frame). Grid type detection is
implemented for software-side motion analysis (both High Performance and High Accuracy modes), while
most devices send their motion detection metadata in the form of areas (frames), this is, the software only
knows if the motion was present in the configured zone, and exact location of the motion in that frame is not
available.

Understandably, precise results of smart search can be only obtained for grid-like detectors. Searching
through an area-type stream by motion region will give you motion events whenever motion has been detected
in the configured detection areas. In order to get better search results with device-side detectors, please adjust
the motion detection zone via device Web interface.

In order to start using smart search, click the corresponding tab on the upper panel of the main Luxriot EVO
Monitor window.

[ Live [> Playback I8L Sequence [7%] Smart search L\ Alerts Library

Smart Search option

When you open Smart Search for the first time since Luxriot EVO Monitor application startup, the main viewing
area will be empty. The resources menu on the left will contain all recorded streams, just like in regular playback:
simply drag and drop your desired video stream onto the viewing area in order to start working with it. The panel on
top of the viewing area will have your selected channel and stream name displayed then. The loaded stream will still
be there if you switch to some other tab and then go back to Smart Search.

1 Live [> Playback 0L Sequence [#] Smart search £\ Alerts Library = Connection (1 servers) Fle  Edit View Help
axis K= axis ¥ Primary

72 Channels

Z:axis

K3 5xs » Primary

Please refine search criteria on right panel and

"G anreh® |
press "Search” button! Set time

Search interval

107472016 B2 11:39:54AM »> 10/4/2006 B 05:39:54 PM

Threshold

i E Search

Smart search with a loaded stream

Search Parameters

The search procedure consists of three main steps: define the region of interest, set the time period and
sensitivity, and analyze the results.
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Once you have selected the stream for analysis, the stream preview will appear in the upper right corner as a static
picture. You can use the buttons below the picture to choose the point in time for the preview: this comes handy in
case the stream comes from a PTZ capable device, or if the underlying device has been moved/replaced. Choosing a
correct scene is crucial for obtaining the correct search results.

Click and drag on the picture to draw a rectangular region of interest. You can mark multiple regions and also
combine them to make them overlap, creating a more complex shape. Press the Clear region button to discard all
areas and start drawing again. If no region is specified, all available motion information will be searched.

Define region of interest

Afterwards, set the search interval using the controls below the picture. You can enter the date manually or use
the calendars to choose a specific day. To manipulate time, click the desired time units and then either enter the
numbers from your keyboard, or use your mouse wheel, while still hovering the mouse cursor over the timestamp.

Next, set the desired threshold for the motion absence by dragging the slider. Threshold range is 5..60 seconds and
it defines how much time should be there between two subsequent motion events for them to be reported as a single
event. For example, if you set the threshold to 55 (minimum), all consecutive motion events with gaps between them
smaller than 5s will be reported as a single search result, and events having more than 5s between them will be
presented as separate results.

When ready, press the Search button to filter the motion events according to your settings. Smart search results
will appear in the central viewing area; if the specified time interval is large, the results may appear not at once but
rather one by one, as the search progresses.

Investigation

Each of the search results will be presented as a preview picture with a timestamp below, the timestamp designating
the beginning of the sought-for motion event. At the same time, all results will be listed on the right-hand side, with
the currently displayed results being highlighted. The list also shows the motion event duration for each of the
results. In the very bottom of the list, the total number of results will be displayed.
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27 Bookmarks

Luxriot EVO Monitor offers an opportunity to mark any specific moment in time so that it can be easily found in
the Playback mode later. It is possible to add bookmarks from live, instant playback, regular playback and smart
search modes, as well as instant playback mode in the investigation tabs. Bookmarks are displayed and can be
searched through in the regular playback mode.

=

‘' The bookmark overlay control may be absent in the following cases:

e your currently logged user does not have permissions to add bookmarks - in this case, the bookmark
control may be absent for specific channels only

e the control had been hidden via application settings (by default, it is enabled)

Also, the bookmark button will be grayed out for orphaned archive tracks in the Playback mode (orphaned
tracks are recordings that have no active channel associated with them).

Bookmark Properties

Bookmarks have multiple severity levels, each one introduced with a different color on the timeline. The default
level is Critical; this severity level is also displayed for all bookmarks created before installing this version.

Bookmarks in the alarm pane also have a status, which allows you to use them for case management. If you have
sufficient user permissions, you will be able to change the bookmark status when the bookmark is opened for editing
from the Alarm pane or in the search mode in playback.

Search

SEVERITY = BOOKMARK TIME TITLE CHANNEL DESCRIPTION
1/11/2023 9:44:26 PM  Wow, a new event! (Generic) ONVIF Co... This is a...
1/11/2023 9:44:26 PM  Another great event (Generic) ONVIF Co...  I'm vacci...

1/11/2023 9:47:26 PM 1/11/2023 9:34:11 PM  Wow, a new event! (Generic) ONVIF Co... Thisis a...

: 1 : 2
AHE ECADEEEE High 1/11/2023 9:34:11 PM  Another great event (Generic) ONVIF Co...  I'm vacci.
Severity: Normal

NArmoa 1/11/7072 0:22:24 DM \Muar » winmt] RE (Cans) DivalDra  Thicic »
Status:  NEW

11 bookmarks(s) found

A Hz2ea pAL N ! | Description
This is a VERY important event with an automatic event
description here. Add more comments if you like.

319:47:25 PM

Cashier #1 (Data)

*Cashier

-
= (Gerericr ONVIF-Compatible-orr192:168:3:0 m—
Add comment

o B mviom 1k s2n p] —

9:44:22 PM

Bookmarks in Luxriot EVO Monitor playback
Bookmark status can be:

e New: the bookmark has been created but has not been commented by anyone (used for case
management)

¢ In progress: once a new bookmark has been modified, its status is automatically changed to In progress
to indicate that the case is being handled

¢ Closed: operators can manually assign this status to indicate that the case is closed
¢ Hidden: also manually assigned

Hidden bookmarks will not appear in search.

Add Bookmarks

You can add bookmarks from almost any viewing mode by clicking the corresponding overlay icon m in the bottom
left corner of the video.
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28 External Services

External services in Luxriot EVO are, primarily, LPR (License Plate Recognition) and FR (Face Recognition)
modules, as well as any system-specific third-party modules that have been integrated with Luxriot EVO via HTTP
API. If additional external services have been enabled and set up for your server(s), these will allow you to receive
live event streams for the corresponding channels and also to investigate the recorded event data together with the
video streams.

Live

If recognition is running for a specific channel, you can see the recognition results by opening the Notification Pane
for each individual channel. The pane can be toggled using the viewport overlay controls, and its availability can be

set up via Application Settings.

pu— : HEB4647 plate was recogmized

{' F58998 plate was recognized

10/1

GR257 plate was recognized

EL7722 plate was recognized

= HB4B47 plate was recognized

OdAELAB

Live view with LPR recognition

The list of the live results is cleared when you close the Luxriot EVO Monitor application meaning that each time
Luxriot EVO Monitor starts with an empty notification pane and it gets filled as the recognition results arrive. The
notification state (ON/OFF) is saved with the layout, local or shared.

If your target channel is recorded, you can double-click any entry to see the moment of the recognition played
back automatically in the same viewport using the instant playback. The recording status is showed by the overlay
icon in the bottom-left corner of the viewport (yellow = recording ON, white = OFF).

Playback

The channels used by external services can be played back just in the same manner as regular channels.

For systems that have FR service(s) connected, an additional control will appear in the bottom right corner, below

the timeline. The Mysterious face icon will allow you to switch to the FR investigation mode using the

current frame. If the target frame contains a face, you can then highlight it and form a search request as described
below. Note that you will still have to specify the channel(s) to be searched in the Resources pane on the left, as the
image may be coming from a non-FR channel.
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29 External Data

Apart from video channels, Luxriot EVO Monitor can present data (textual data) from various sources, for example,
transaction data from POS machines. Other types of data sources may be ANPR readings, barcode data, car
weighing data, etc. The text may come overlaying the video streams or in separate visualizations called data
channels.

In Luxriot EVO Monitor, you can do the following with the data:

e view the live data in video overlay or as a data channel
e play back the recorded data using instant playback
e play back the recorded data using multichannel playback*
e export snapshots containing textual data
e export video clips containing textual data with or without video
e search the recorded textual data
e run more complicated queries across available databases
Based on the server side configuration, your Luxriot EVO Monitor instance may also produce events based on

keywords or key values received from the data sources. For example, in a store, you may want to have the video
popup on a bigger screen when the customer's purchase total exceeds 100$.

*If you have data channels for dedicated data view, arrange and save layouts that contain both data and video
channels so that you can view the related information together (e.g., in a store there is a camera overlooking three
self-checkouts.

Live Data Streaming

Depending on the system configuration, you may encounter two types of data presentation.
1. Video overlay

Textual data from the associated external data source will appear embedded with the live video stream. This
happens automatically and you do not have to do anything else in Luxriot EVO Monitor to enable the video overlay.

923 eIl 28 591:?§eae; Transaction Sta
2023102/ 1+, 18 - 24 J54%E

@00 15.44 61.76 J

2023 .02 1191 8 : 24

Code

2023.

9.16

2023,

Code

2023.62.11,.18:25:

2o 3.

2023.02.11

Code 07774

2023.02.11 ;03" POSPee1N colby,
200 8.62 8. !
2023.02.11

Code ©9358

JPEG 1.8MP 10FPS 25.8 Mb/s
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30 Video Analytics Events

Playback section has a special investigation mode that allows browsing the archive based on the video analytics
events. These events may come from:

e server-side video contents analysis (VA) engine,
e server-side VA engine,

e server-side Open VCA engine,

e and camera-side analytics (onboard/edge VCA).

Events from the server side must be pre-configured to be recorded together with the video stream. These
are displayed in Luxriot EVO Monitor and can be investigated and also exported to an external file in the comma-
separated format.

' VCA event data are available for server-side analytics and also for camera-side VCA in case metadata are
supported for that particular camera brand. For the exact manufacturer list with VCA metadata support,
please contact Luxriot representative.

In playback, VA and VCA metadata are represented by a thick white stripe over the footage. This means, these events
can be searched for in the Playback mode. To access the VA investigation panel, go to playback mode in Luxriot EVO
Monitor and click the VCA button in the top right corner.

=

'/ Earlier Luxriot EVO versions had a continuous timeline stripe for VA metadata. Starting from v.1.20.0,
metadata are displayed similarly to motion, with the timeline overlay only present during periods with
analytics detections.

. @ O L = Connection (2 servers)  File  Edit  View Tools  Help

M Bookmarks =0 VCA B® Archive Calendar

Source

Selected channel (FR)

Source to search for

Search interval
2/15/2021 & 04:20:07PM > 2/15/2021 & 10:20:07 PM

Search in the specfied time int

Search for

SOURCE CLASS NAME

Y 2/15/2021 9:59:22 PM FR person, 0.74

3242 item(s) found Export CSV...

Video analytics event investigation in the playback mode
The appeared panel will allow you to specify the search criteria, which are:

e Source: a channel currently present in the layout that has VCA enabled
e Search interval: time range to look for the events in
e Search for: VCA/VA item to search for, can be an object, a counter or an event
e Object: all entries containing object appearance according to the VCA/VA object classification
e Counter: all moments where any counter value was changed
¢ Event: all entries from triggered VCA rules
¢ Class name: VCA or VA class name (full or partial) according to the VCA/VA internal object classification
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31 External Video Analytics

Luxriot EVO Monitor allows establishing a direct interactive connection to third-party video analytics servers
(or other software servers) via HTTP/HTTPS. These providers are external to the Luxriot EVO system but they may
run the analysis on the same video streams. The main purpose of this feature is to provide you with a single
interface, eliminating the need to switch between several different applications.

A prominent example of such a VA system is the Active Guard server by i-PRO. It will provide you with the
video analytics search options based on many different parameters: persons' appearance, faces, etc. (the specific VA
options depend on the video analytics configured on the camera side). If the same cameras are present in the Luxriot
EVO configuration, you will be able to view the archive locally when inspecting the analytics events.

By default, there are no built-in connections to any systems, and the functionality is hidden.
Enable Video Analytics Connections

To enable the feature in Luxriot EVO Monitor:

Run the Luxriot EVO Monitor configuration tool: main menu Tools > Administration tool
Enable the Video Analytics Connections under Menu Buttons in the Interface tab
Restart the Luxriot EVO Monitor application

The corresponding menu item should appear in the main application menu, under Edit > Video Analytics
Connections

Sl

Create Analytics Connection

Now, you need to create the VA connection(s) similarly to Luxriot EVO server connections.

= Connection (4 servers) File Edit View Tools Help

1

f

Settings

Command Mapping

Theme

Video Analytics Connections

Video analytics connections
Manage video analytics connections

Access the VA connection settings via Luxriot EVO Monitor main menu

To do this, go to the main Luxriot EVO Monitor menu and choose Edit > Video Analytics Connections, add a new
server, then fill in the connection settings:

o Server title: user-defined analytics instance name
e [P address: IP or hostname of the target Web application instance
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32 Alarms and Notifications

The Luxriot EVO Monitor application has several ways of displaying different notifications received from the
servers. Depending on the alert type and/or configuration, they may appear in the live notification pane (channel
overlay), in the Alarm pane, in the dedicated Alerts tab, or as popup dialog boxes.

) If you want to send alerts to Luxriot EVO Monitor from Luxriot EVO servers, use the Event & Action
Configurator in Luxriot EVO Console. Use the Send event to client and Create bookmark action types.

Notification Panel

Each channel in the live view has an overlay notification panel. It is hidden by default and can be toggled by

clicking the corresponding overlay element in the bottom-right-hand corner of the viewport. Depending on
your application settings, this overlay control may be disabled, shown always, or only shown when the viewport is
selected (default setting).

/2019 15

man, don't look so scared

1 15

THE operation timed out

Failed to connect to device

X N IPEG SMP 2FPS 4.1Mb/s o R R @

Notification panel overlaying live video

This pane displays several types of messages related to the target channel:

e streaming errors (RTSP, wrong password, etc.)

e text notifications from E&A (pre-configured)

o results from external services (e.g., recognized license plates with thumbnails)

e other custom event messages (pro-configured on the server side via Luxriot EVO Console)

Messages related to the video archive (e.g., recognition results) are interactive meaning that you can double-click
them to go to that moment in the archive.

For this panel, there are two configurable settings in the application settings: font size and an option to display
thumbnails (tiny images) for the external service results. You can also adjust the panel appearance for each
viewport individually; for this, long press your left mouse button on the panel and then click the Edit button (with
the pencil). The process is described in more details in the Overlay section of this document.

Alarms Pane

Alarms are generated by the connected servers or created "on the fly" by the user. You can find the Alarms Pane
from the right side of your Luxriot EVO Monitor in the Live View mode. Alarms, in their essence, are the
Bookmarks and possess all their features: Severity, Color, Status, and Comments. Alarms (Bookmarks) are
also available through the Search in the Playback mode of the Luxriot EVO Monitor application.
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33 Access Control

If your Luxriot EVO server employs a connection with a third-party access control system, it is possible to view
events and other data from the integrated module in the Luxriot EVO Monitor application.

Here is an example of how this can be done based on the connection to Doors .NET, which is possible thanks to the
integration of Luxriot EVO with Keri Systems.

Access Control

To start working with the access control data, switch to the Access Control tab in your Luxriot EVO Monitor

application.

[l Live [> Playback 35 Sequence [ Smart Search

Events Doors Cardholders

TIME

20.02.2018 10:28:06
20.02.2018 10:28:.04
19.02.2018 18:07:
19.02.2018
19.02.2018 18:07:41
19.02.2018 18

19.02.2018 18:

19.02.2018 18:05:47

19.02.2018 18:02:24

EVENT

Reader Mode Change - Unlocked
Reader Mode Change - Card Only
Reader Mode Change - Unlocked
Reader Mode Change - Card Only
Reader Mode Change - Unlocked
Reader Unlocked, Door is Open
Reader Contact - Held Open
Reader Mode Change - Card Only
Reader Unlocked, Door is Open
Reader Mode Change - Unlocked

Reader Contact - Held Open

DOOR
Front Door - CO 81
Front Door - C0 B1
Front Door - CO B1
Front Door - CO B1
Front Door - CO B1
Front Door - CO B1
Front Door - CO B1
Front Door - CO B1
Front Door - CO B1
Front Deor - CO B1

Front Door - CO B1

LN Alerts Library =[] Aceess Control

Ronald G Merino

View cardholder events

= Connection (2 server: Fi Edit  Miew Development

Front Door - CO B1
Interval

Reader Mode Change - Unlocked
19.02.2018 &8 11:312:24 » 20.02.2018 11:12:24 £ 9

Cardholder

23 event(s) found

Access control tab
There are three sections available here:

¢ Events: the list of door events
¢ Doors: door list with statuses
e Cardholders: the list of cardholders

Click any event to view its details and associated recorded video (if a channel has been bound to the door in Luxriot
EVO Console). Events can be filtered based on time, door name, cardholder and/or event name (or a part of it).
Playback will appear on the right side as instant playback, with all usual controls, when an event is selected.

Click any door in the list to view its live status and associated live video (if configured). Every door will also have
three buttons to let you lock, unlock or temporarily unlock it. The View door events button will take you to the
Events section, with the event list filtered and only displaying entries related to the selected door for the last day.

In the Cardholders section, you will have the list of cardholders with pictures, if there are any. Use the Refresh
button in the bottom to reload the list. The View cardholder events button on the right will take you to the Events
section, similarly to door events: the event list will only display events for the target cardholder for the 24 hours.

Maps

Apart from the dedicated Access Control sections in Luxriot EVO Console and Luxriot EVO Monitor applications, it
is also possible to place door markers onto maps — either regular ones or geo maps. Markers on the map reflect door
open state and lock state. If such maps have been configured on the server, they will be available in the
corresponding section on the left, in the Resources panel.
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34 Reports

Reporting mode in the corresponding Luxriot EVO Monitor tab provides reporting functionality based on the
previously collected data. There are two types of reports: heatmaps, based on motion information, and charts,
which use data from the software and VCA counters. You can view the reports in the application and then export the
results.

Heatmaps

Heatmap type reports represent motion density in the picture, thus highlighting the regions where the most
motion has happened during the selected time range. Heatmaps are generated based on the motion detector
(MD) data, therefore, motion detection must be enabled beforehand for the target channel via Luxriot EVO Console
application.

Here are the requirements and some recommendations regarding heatmap reports:

e target channel must have grid type MD enabled

e motion information must be recorded with the video (represented by cyan color on the timeline in
playback mode)

o for PTZ cameras, make sure to select a static interval (during which the camera was not panned, tilted or
zoomed), otherwise the map will be inaccurate

e if you are using server-side MD and your video stream has camera-side timestamp overlay, make sure to
add it to MD exclusions via Luxriot EVO Console (otherwise, the changing digits will trigger false motion
and your heatmap will be biased)

) Heatmaps use data from grid type motion detectors. Grid is guaranteed for software-side MD, and also for
a few device-side detectors. Heatmap detailization depends on the MD grid size: the smaller the grid cell, the
finer the map will be. Hardcoded internal grid size for the heatmaps is 128x128.

Most of the device-side MD do not support grid mode: if this type of MD is enabled in the device properties in
Luxriot EVO Console, you will get an "unsupported MD configuration" error and the heatmap will not be
generated.

To start, drag and drop a channel from the resources panel on the left. The channel name will appear on top of the
viewing area. If, for some reason, there is no motion data, or it is incompatible (frame type instead of grid), you will
get a corresponding error.

Next, select the target time interval, days and hours to be analyzed:

e Heatmap interval: defines the total report period
¢ Filters: define the target range of time and exact days to be taken into account

For example, you can select one month as the time interval, and then only select weekdays (Mon-Fri), from 8AM to
8PM.

Use the Set time, +1h and -1h buttons below the channel preview to select the image to be used for the heatmap
overlay. Particularly, this makes sense for PTZ or zoom-only cameras, where the snapshot time matters. Also, you
might want to use this option to find a timestamp where lighting conditions are optimal, or there are no unwanted
objects in the scene. Use the Reset filters button below the settings in the right-hand panel to restore the default
filters (all days 24/7).

When ready, hit the Generate heatmap button: depending on the selected interval, this may take some time, and
you will see the generation progress displayed as percentage.
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35 Video & Snapshot Export

Video clips, frame sequences, multichannel layouts and individual pictures can be exported in order to be viewed
later without Luxriot software.

! Please consider that Windows 10 and 11 do not include h.265 codec by default - you cannot play h.265 videos
with a built-in Windows media player. You can export videos with conversion to other formats (please refer to
the corresponding topic); you can buy h.265 codec separately in the Microsoft store or use VLC or a Portable
player to play videos in h.265 format.

Snapshot Export
A snapshot of an individual channel can be taken at any time from live view, sequence explorer, instant playback and

regular playback modes. To save a snapshot, click the Snapshot button in the overlay controls or bottom panel
controls. If you have pre-defined the snapshot export settings in the application settings, the frame will be saved
immediately; otherwise, a dialog box will pop up, prompting you to specify the save parameters. Please check the
topic on application settings for detailed description of each parameter.

If the picture was dewarped or zoomed in using DPTZ, the snapshot will contain the target region.

If the channel has video analytics configured, all currently displayed visual elements will be exported with the
snapshot. To change VA element visibility in Luxriot EVO Monitor, go to the Application settings and change the
VCA settings in the Video overlays tab. All elements that have the Always On and On if selected settings will be
embedded into the snapshot, while elements that have the Always off setting will not be exported.

In playback mode, it is possible to export a snapshot that will consist of all channels present in the current layout. To
do this, use the Multichannel Snapshot button in the right side of the bottom panel. The resolution of the
combined frame is 3840x2160px.

The frames will be saved with your pre-defined frame export settings, if this option is enabled in the Application
settings; otherwise, you will be prompted to specify the file name and quality preference. After you have clicked the
snapshot or multichannel snapshot button, the frame will be automatically saved in JPG format and will appear in
the Library section of Luxriot EVO Monitor.
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36 Case Export

Luxriot EVO Monitor offers a specialized feature called Case Export, which allows asynchronous video export with
adjustable time intervals. By exporting cases instead of regular archive, you create a "story" video from all the
available channels, with different intervals. For example, exporting evidence of a person running across multiple
streets as a case may be preferable over regular (synchronous) export because it will save time for the person
watching the footage.

Case export is a two-step process:

1. Case creation
2. Video export

Creating Cases

A case is a set of video archive intervals. which can be exported as a single video file. At the case creation stage, you
choose the video channels and the corresponding time intervals for each one. From each channel, multiple entries
can be added.

Example: for the abovementioned scenario with the running person, you can add the archive from multiple cameras
and limit each channel's output to the time when the person was visible in the frame.

) Any user with Playback access rights can create a case for the export.

To create a new video export case in Luxriot EVO Monitor, go to the Playback tab and press the Case Export button
in the upper right corner to bring up the case export panel. Then follow these steps:

. Press the +Create button, then fill in the Case Title and Case Description

. Drag and drop the desired channel onto the viewing area

. Select a channel by clicking it in the viewport

. Press the Add entry button in the Case Export panel

. Adjust the time interval by dragging the start and end markers on the timeline

. Repeat steps 2-4 as many times as you need to compose the Case

7. Press the Save button at the bottom of the Case Export tab to save the case and go back to the case list

NP W N =

If you wish to discard the changes, click the Cancel button instead of saving the case. If you move across tabs, the
currently edited case will be preserved. If you close the Luxriot EVO Monitor application, the unsaved changes will
be lost.
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37 Cloud connector

(BETA Version)

Overview

The Cloud connector is a new BETA feature that allows you to connect to the Luxriot EVO S servers with Luxriot
EVO Monitor and Luxriot EVO Console through the dedicated cloud instance. Such a connection may be helpful
when access needs to be granted for a short period and/or the network configuration does not allow a direct
connection. We provide our cloud instance to punch a hole or use UPnP while providing a trusted connection

between the server and client applications.

/ PLEASE, CONSIDER THAT YOU ARE USING BETA VERSION OF THIS FEATURE. WE CAN'T
GUARANTEE IT'S STABILITY. ALTHOUGH WE ARE HAPPY TO RECEIVE YOUR FEEDBACK THROUGH
OUR SUPPORT ENGINEERS, SOME ISSUES MAY BE RESOLVED ONLY WITH THE NEXT RELEASES.

Connecting Luxriot EVO Monitor to the Server via Cloud

You can connect to the preconfigured server using the provided token. If you have such a token, go to:

1. Luxriot EVO Monitor -> Connection and click the + Cloud server (beta) button

s Library  [] Access Control [ulls Reports @) VA Investigation = Connection (3 servers)  Ffil=  Edit

ser . Connections X

= Cloud server (beta) Disconnect all

The Connections pop-up window

2. Paste the token into the dedicated field. If the provided token matches the format, a new pop-up window with
the server list will appear. If any prior connections were established and the token wasn't unregistered on the
server side, you can select it from the dropdown menu and reconnect.
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38 Video Sharing

(BETA Version)

Overview

Welcome to the Luxriot EVO video-sharing beta program! We are excited to introduce a new feature for instant
video sharing to any device with the browser and internet access!

/. PLEASE, CONSIDER THAT YOU ARE USING BETA VERSION OF THIS FEATURE. WE CAN'T
GUARANTEE IT'S STABILITY. ALTHOUGH WE ARE HAPPY TO RECEIVE YOUR FEEDBACK THROUGH
OUR SUPPORT ENGINEERS, SOME ISSUES MAY BE RESOLVED ONLY WITH THE NEXT RELEASES.

Key Features and Functionalities

This feature allows you to share videos via links directly from the Luxriot EVO Monitor application and
automatically email them or copy and share links manually.

Key functionalities:

Video clips are marked in the Luxriot EVO Monitor application and shared with target emails
Email and 2FA verification are available as security options

Sharing duration can be limited by time

Shared video is accessible in any browser via provided link

In the software version 1.28, the video-sharing feature is available in a BETA with the following nuances:

e For Luxriot EVO S only

e Link sharing and video streaming are available via the cloud (the Luxriot EVO S must be registered in the
cloud)

e Video only (no audio)
We also keep in mind your security so that the links can be protected by email (passcode) and verification code
(2FA)
Sharing the video via the Cloud

If the Sharing options are configured by your administrator, you will be able to share any recorded video directly
from the Luxriot EVO Monitor. To do so:

1. Open the Luxriot EVO Monitor -> Playback
2. Select Viewport with the video you want to share

3. Mark the section of the video on the Timeline with the Custom Selection too] i

-
4. At the bottom-right corner, locate the Video Sharing icon and click it
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39 Library Section

The library displays all the exported video files and snapshots that are available, as well as ongoing export jobs.
Essentially, the library section merely displays the contents of the directory, which has been set in the application
settings as target folder for the exported files. The file list is refreshed upon Luxriot EVO Monitor startup and every
five minutes after that, so if some files are removed manually via Windows Explorer, it will take up to five minutes
to synchronize the changes.

Files that are still being exported (current export jobs) will be shown in grey, with the current export percentage
shown in the Status field. After that, the entries stay in the list with related details and export status.

(7% VMS Client Application == O

CJ Live  [> Playback I Sequenceexplorer  /0\ Alerts  [&] Library = Connection (1 servers)  Fle  Edit

117

Open Show in Windows Explorer safected | [

L

x
2015-12-29 15-56-46-358 Axis 215 PTZ on 192.168.3.4.jpeg 12/29/2015 3:56:46 PM 39.2 KB
2015-12-29 17-20-34 Axis 215 PTZ on 192.168.34.avi 12/29/2015 33521 PM 559.74 MB
2015-12-29 17-27-52 fogs 215 PTZ on 192,168 3.4.an 12/29/2015 3:32:54 PM 228.18 MB
2015-12-29 15-11-00 M2 on 192.168.3.5.av Done 12/29/2015 3:20:14 PM 143 GB

2015-12-29 16-00-43 M2 on 192.168.3.5.av Done 12/29/2015 3:04:17 PM 65.07 MB

Library section

Click the Open button on the upper panel or just double-click any file to open it with your OS default media player:
exported video files and images can be opened by standard media players (Windows Media Player, VLC etc.). This
normally works for AVI and JPG file formats; for other video formats (MKV, MP4), you may require the Portable
Player tool.

Use the Show in Windows Explorer button to display the export directory containing the selected file.

To remove files both from the library and from the hard disk, select one of multiple files and click Delete button on
the upper panel. Use the Search field in the upper panel to filter the items.

File Export to External Media

Click any file or files and hit the Copy to... button on the upper panel if you want to copy the target file(s) elsewhere,
i.e., on a USB drive, a CD/DVD etc. File copy dialog box will appear; click Browse and select your desired location.

Copy to x|

Destination

=1 /% Computer =
&L Local Disk {C:) _J
ARl DD R el (D)
[# 1) BO-ROM Drive (E:)
[£] g Newe Volurme {F:)
[ =y BO=ROM Drive {G:)
] ¥l Nebwork
= 5 Control Panel
Recycla Bin
: =

| ' | i |
Mak&NanlderJ ok | Cancel ]

[ Append Watermark Validator

Choose destination

If you choose a regular disk or a USB drive as a destination, your file(s) will be simply copied into that directory.
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40 Video Overlay

Channel Shortcuts

Channel shortcuts are interactive video overlay elements in live view and playback, which allow you to switch to
other (pre-defined) channels. These can be thought of as "portals" to other channels. A simple usage scenario is to
place shortcuts on doors or street turns, so that users can track people as they move between the different camera
views.

Shortcuts are configured in Luxriot EVO Console and then are visible in the Luxriot EVO Monitor application as
colored rectangles overlaying the video. Single clicking them will instantly display the linked resource instead
of the current channel. The shortcuts only work in live view and multichannel playback, and are invisible in other
modes.

=

¢ Prior to the software version 1.24, channel shortcuts were only available in Live View.

Street view camera with channel shortcuts

If the feature is not used, you can turn OFF the overlay visibility in the Luxriot EVO Monitor application settings:
this will disable the shortcut functionality. To do this, go to the Luxriot EVO Monitor main menu Edit >Application
settings > Viewport overlays > Video overlays section and select the Always OFF option.

Text Overlay From Data Sources

If the connected server has data sources configured and these are associated with video channels, the received
textual data are displayed in Luxriot EVO Monitor application embedded with the video in the live view and in the
instant and regular archive playback, and it is also possible to search through the recorded text.

Live View

Textual data from the associated external data source will appear embedded with the live video stream. This
happens automatically and you do not have to do anything else in Luxriot EVO Monitor to enable the video overlay.
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41  Appearance and Operation Modes

Time Presentation

Timestamps displayed for live streams and playback (regular/instant) are using local time by default. You can
change this to UTC or to the time zone of a specific connected server: this is useful when you view contents from
many servers located in the different time zones.

You can access this setting via main menu View -> Time Presentation -> [option].

= Connection (2 servers)  File  Edit View Tools Help

Local Time Zone o iime Presentation

Universal Time Zone Always On Top

Server Time Zone Exclus Mode

Lock Application

' Time presentation settings do not affect event logging (Alerts tab). Also, when you export a video clip from a
remote server, which is in a different time zone, and add timestamps in subtitles, your local time will be used.

Operation Modes

Luxriot EVO Monitor has three special operation modes:

e always on top
e exclusive (no access to other applications or resources)
e locked (all Luxriot EVO Monitor controls are unavailable)

You can activate these by selecting the relevant option via main menu View -> [option].

Each next operation mode includes the previous one. Thus, exclusivity mode also makes the application stay on top,
and the lock application mode also makes it exclusive and on top.

) In order to use these modes on Windows 8, 8.1, 10 and Windows Server 2012 - the operating systems
having Windows Metro interface design - it is necessary to disable Windows Logon Screen. Without doing it,
exclusivity mode and locked application mode can be overridden by using Windows button.

In order to do so, go to your Start menu and locate the following shortcuts under Luxriot EVO category:

e Disable Windows Logon Screen controls - this one will disable Windows interface elements, allowing
you to use Luxriot EVO Monitor operation modes properly

e Enable Windows Logon Screen controls - this one will enable Windows welcome screen back

After disabling the Windows Logon Screen controls, launch Luxriot EVO Monitor and use application
operation modes as required.

Exclusivity and locked modes require a password to be defined, and this can be set in Application settings. If you
have not already set a new password, you will be prompted to do so upon enabling the exclusivity/locked mode.
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42 Themes

Luxriot EVO Monitor color scheme can be modified by changing the colors of individual elements and/or element
groups: buttons, date/time pickers, overlay controls etc. This functionality is available through Luxriot EVO Monitor
main menu Edit -> Theme.

Theme settings dialog box

All elements whose color can be changed are grouped logically within the list and shortcuts to the groups are listed
on the left hand side.

Color palette consists of three sections:

e available colors: hues used in default Luxriot EVO Monitor looks

e standard colors: pure hues with names (e.g., white, gray, purple etc.)

e advanced settings: fully customized color choice from RGBA (red, green, blue and alpha for transparency)
color picker

All colors are coded in 8-digit hexadecimal RGBA notation; colors from the standard palette can be also referred to
using names, for example, black, white, red etc.

As you change the colors, they are immediately applied to the application theme. Once you have created the
desired color arrangement, you have the following options:

e Save as: save the theme settings into a XAML file

e Save: save latest theme modifications and exit

¢ Cancel: discard the latest changes and exit

¢ Load defaults: discard all changes and reset the colors to Luxriot provided

e Export: save the theme into a file and use it on another workstation

e Import: load a theme file from another workstation, or an earlier version of it

To load a XAML file formed on another workstation, use the Import button.

Alternativelv: take the Brushes.xaml file generated previouslv and put in into the AppData directorv:
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43 Administration Tool

It is possible to customize Luxriot EVO Monitor looks by restricting certain functionality if users are not supposed to
see specific tabs, panels and/or menu items. This can be achieved by using the Luxriot EVO Monitor administration

tool, which is available via Windows Start Menu, under Luxriot EVO, or via Luxriot EVO Monitor application's main
menu View -> Administration Tool.

/. Windows Administrator rights may be required to launch this utility (UAC in action).

Set Restrictions

After running the tool, simply unmark the features that you do not wish to appear in the Luxriot EVO Monitor
application on the current machine.

Every listed item is enabled by default; by unchecking (unmarking) them, it is possible to hide the corresponding
features from the Luxriot EVO Monitor user(s). Note that these settings are only applied to the Luxriot EVO Monitor
application instance running on the local machine and are not related to the user accounts used for server
connection, or applications running on other machines. In other words, for example, if you restrict access to the Live
tab, it will be hidden for both regular users and also the root administrative account(s).

Luxriot EVO Monitor administration tool
The tool offers the following functionality restrictions:
Interface visibility settings

e Panes

e Layouts: the whole pane containing layouts, layout templates and layout sequences on the left
hand side

¢ Local layouts and templates in the resources pane on the left hand side, for both live
and playback modes

¢ Shared layouts and templates: server-side resources, for both live and playback
modes

e Layout sequences (local only)

¢ Channels: channel and channel visual groups in the resources panes in the left hand side of live
view

e Playback channels: channel and channel visual groups in the resources panes in the left hand
side of regular playback mode

e Alarm pane: the floating panel on the right-hand side containing bookmark alarms
e Tabs

o Tive: live view ceetinn (all cecondarvy windowe will he remaved ac thece are anlv canahle of live
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44  Archive Backup Wizard

Luxriot EVO offers an option to back up any recordings from any server manually, in the proprietary Luxriot EVO
archive format. Video, motion information, audio, VCA data streams, as well as external serial data can
be extracted from the original archive and saved elsewhere, with an option to include the portable player tool so
that the downloaded recordings can be played on any Windows-based computer, even if it has no Luxriot EVO
installed.

The wizard is included with any Luxriot EVO installation, including Luxriot EVO Console management application
and Luxriot EVO Monitor application, and allows connection to local and remote servers.

) The archive will be copied to the computer that has Archive backup wizard running on it. Thus, if you are
connecting to a server remotely via Archive backup wizard, the archive copy will be downloaded to your
computer from the server. As footage may be of significant size, make sure you have the required bandwidth
available.

Start the Archive Backup Wizard from the Windows Start menu: Start -> All Apps -> Luxriot -> Archive
Backup Wizard (in Windows 7 and older versions, use Start -> All Programs -> software installation folder -> Tools
-> Archive Backup Wizard); alternatively, use Search to locate Archive Backup Wizard in the programs menu.

From the Luxriot EVO Monitor application, the wizard can be launched via main application menu by opening View
-> Archive Backup Wizard and choosing the server (one of the connected ones). The address of the server, and also
the username and password, will be taken from the currently configured server connection.

Using Archive Backup Wizard

First, you will be asked to log into the target server: your user account must have an administrative permission to
make archive backups plus permissions to back up footage from individual channels/channel groups. You can create
archive backups from the local server or from any remote server (login procedure is analogous to Luxriot EVO
Console login), including individual recording servers. If you run the wizard from the Luxriot EVO Monitor
application, you will not be asked to log in; instead, your configured server connection will be used.

After you log in, you will be presented with the list of available recordings, grouped by channel and, if present,
by visual group. Select the channel(s) and/or visual groups you need by putting a checkmark next to each one;
specify the required time range above the channel list and click Next.
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45 Portable Player

Luxriot EVO Portable Player is a standalone application designed and optimized to play back media exported
from Luxriot EVO as well as native Luxriot EVO archive. Original archive playback also includes the opportunity
to save snapshots and export video clips into the player own library.

Portable player can be optionally appended when you copy exported files from Luxriot EVO Monitor to an external
location (burn to CD/DVD etc.), and can also be obtained from Luxriot either directly or from the website,
downloads section. This application can be transferred to any Windows machine that does not have Luxriot EVO
installed and used for viewing archive recorded by Luxriot EVO and video clips exported from such an archive.

Portable player interface
The player has three tabs:

e Media Playback: for video clips that have been exported from Luxriot EVO Monitor or Portable Player
(*.avi and other file types)
e Proprietary Archive Playback: for the native archive playback (original Luxriot EVO archive structure)
e Library: own Portable Player library containing video clips exported from the native archive playback
mode
Below, you will find details on each mode.

The player main menu, located in the upper right corner, gives you the following options:

e TFile

¢ Add file/folder/archive: append a file or directory contents to the current playback list
(Channels section on the left)

¢ Exit: close the application

o Edit
e Settings: overlay, language and media export preferences (see below for details)

e Help
e About: software version and legal information

Settings

Application settings are pretty much alike Luxriot EVO Monitor settings and include the following:

e General tab: change the language and set the default setting for aspect ratio here
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46 Renderer Test Utility

Luxriot EVO can utilize GPU for some operations in order to decrease the CPU load. To enable GPU acceleration,
run the Renderer Test Utility from the Luxriot EVO suite on the Luxriot EVO Monitor workstation.

There are two supported GPU operations are:

¢ frame decoding on Luxriot EVO Monitor side
¢ rendering on Luxriot EVO Monitor side

/. GPU acceleration limitations:

e Only Windows 10 and corresponding Windows server OS editions (2016, 2019), or Windows 11.
e Only H.264 and H.265 streams for live view and digital PTZ in live view

e For fisheye image dewarp, only Fisheye-II is supported (choose the Fisheye lens (6 MP and larger
resolution) option in Luxriot EVO Console)

All other cases will use CPU for decoding/rendering operations.

Before configuring GPU acceleration, make sure you have installed the latest official drivers for all your graphics
cards. We also recommend having more memory for GPU (the more, the better). For integrated video cards, you
can change this setting in BIOS. For discrete graphics, choose ones with more onboard memory (1GB per display or
more).

For H.265: decoding is only available for the graphics cards that have HEVC support. Please check with the video
card manufacturer for the specifications.

GPU Test and Configuration

On every client workstation where you want to enable GPU usage, launch the Renderer Test Utility by locating it in
the Start menu, or simply by typing a part of the name in the Windows search. You can also run this wizard from the
Luxriot EVO Monitor application itself via main menu Tools > GPU configuration wizard. The client application
will be closed during the test and then re-opened.

The first wizard screen is a summary. Here, you can select, which graphics cards will be used for decoding and for
3D rendering. To be able to do so, first run the GPU test so that Luxriot EVO can learn about your GPU capabilities
and determine the maximum possible load. During the test, each GPU is consequently loaded with test videos of
different resolutions, starting from bigger ones. As a result, a value list is created for each GPU, which is then used
by the Luxriot EVO Monitor application for load balancing.

) We recommend that you re-run the GPU test after each system change that may be related to graphics, as
well as major OS updates (like feature updates) and Luxriot EVO software upgrade.

To run the performance test: hit the Test GPU button in the bottom left corner. In the list, mark all GPUs that you
wish to engage by putting check marks in the Test column. Then, select the target codecs, and click the Test button
below.
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